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АННОТАЦИЯ

Методические рекомендации разработаны для студентов по профессии 54.01.20 Графический дизайнер по МДК.01.02 Проектная графика и предназначены для выявления уровня сформированности общих и профессиональных компетенции в рамках модуля МДК.01.02 Проектная графика
Методическая разработка содержит теоретический и практический материал по МДК.01.02 Проектная графика


 
ВВЕДЕНИЕ

Основное назначение дисциплины «МДК.01.02 Проектная графика» в средних профессиональных образовательных организациях состоит в формировании у студентов общих и профессиональных компетенций: выбирать способы решения задач профессиональной деятельности, применительно к различным контекстам; осуществлять поиск, анализ и интерпретацию информации, необходимой для выполнения задач профессиональной деятельности; планировать и реализовывать собственное профессиональное и личностное развитие; работать в коллективе и команде, эффективно взаимодействовать с коллегами, руководством, клиентами; осуществлять устную и письменную коммуникацию на государственном языке с учетом особенностей социального и культурного контекста; проявлять гражданско-патриотическую позицию, демонстрировать осознанное поведение на основе традиционных общечеловеческих ценностей; содействовать сохранению окружающей среды, ресурсосбережению, эффективно действовать в чрезвычайных ситуациях; использовать средства физической культуры для сохранения и укрепления здоровья в процессе профессиональной деятельности и поддержания необходимого уровня физической подготовленности; использовать информационные технологии в профессиональной деятельности; пользоваться профессиональной документацией на государственном и иностранном языках; планировать предпринимательскую деятельность в профессиональной сфере; осуществлять сбор, систематизацию и анализ данных, необходимых для разработки технического задания дизайн-продукта; определять выбор технических и программных средств для разработки дизайн-макета с учетом их особенностей использования; формировать готовое техническое задание в соответствии с требованиями к структуре и содержанию; выполнять процедуру согласования (утверждения) с заказчиком.
Практическое занятие – это форма организации учебного процесса, предполагающая выполнение обучающимися заданий самостоятельно и под руководством преподавателя. Дидактическая цель практических работ – формирование у обучающихся профессиональных и практических умений, необходимых для изучения последующих учебных дисциплин, а также подготовка к применению этих умений в профессиональной деятельности.
Практические занятия предполагают работу с дизайнерско-конструкторскими модулями. Структура практических занятий включает в себя:
· теоретические вопросы по изучаемым темам,
· практические задания для решения с помощью программных средств.
Разработано содержание практических занятий, определена их цель, даны методические указания по выполнению заданий и упражнений, указана литература. Структура рекомендаций соответствует структуре курса «Проектная графика».

 (
85
)
ПРАКТИЧЕСКАЯ РАБОТА 1.

Цели: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы
1. Интерфейс приложения Adobe InDesign.
2. Понятие и типы фреймов.
3. Создание пустых, текстовых, графических фреймов.
4. Назначение диагональных линий в графических фреймах.
5. Основные операции работы с объектами.
Задание 1. Опишите назначение палитр приложения Adobe InDesign.


	Палитра
	Назначение

	
	



Задание 2. Опишите технологии создания фреймов.


	Тип фрейма
	Технология создания фрейма

	Пустой фрейм
	

	Текстовый фрейм
	

	Графический фрейм
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Задание 3. Каково назначение диагональных линий в графических фреймах?
Задание 4. Создайте прямоугольный графический фрейм.
Задание 5. Создайте квадратный графический фрейм.
Задание 6. Создайте овальный графический фрейм.
Задание 8. Создайте фрейм в виде звезды.

Задание 9. Нарисуйте линию под углом в 45 градусов.
Задание 10. Опишите основные операции работы с объектами.


	Команда
	Технология выполнения операции

	Выбор объектов
	

	Перемещение объектов
	

	Дублирование объектов
	

	Создание решетки объектов
	

	Изменение размеров объектов, масштабирование
	

	Вращение объектов, наклон объектов
	

	Выравнивание объектов
	

	Группировка (разгруппировка) объектов
	

	Блокировка объектов
	



Задание 11. Если текстовый фрейм на левой странице не выделен, воспользуйтесь инструментом выделения ([image: ]), чтобы выделить его сейчас.
На панели инструментов щелкните на инструменте прямого выделения ([image: ]). В углах выделенного текстового фрейма теперь отображаются четыре небольшие точки привязки. Точки привязки являются полыми, это указывает на то, что никакая из точек привязки не выделена (А) невыделенная точка привязки; В) выделенная точка привязки).
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Выделите точку привязки в верхнем левом углу текстового фрейма и перетащите ее вниз так, чтобы она зафиксировалась на горизонтальной направляющей, расположенной под этой точкой привязки. (Начав перетаскивание, можно нажать и удерживать клавишу SHIFT для ограничения перемещений только вертикальным направлением.)

Убедитесь, что вы перетаскиваете только точку привязки, если щелкнуть непосредственно под точкой привязки, то при перетаскивании указателя будет перемещаться текстовый фрейм.
[image: ]

Нажмите на клавиатуре клавишу V, чтобы переключиться на инструмент выделения.
Чтобы видеть на экране и ограничивающий контур и путь, выберите команду меню View › Show Frame Edges (Вид › Показать границы фреймов). Чтобы снова выключить отображение границ фреймов, выберите команду меню View › Hide Frame Edges (Вид › Скрыть границы фреймов).
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А. Ограничивающий контур. В. Фрейм

Далее вы измените текстовый фрейм на правой стороне разворота, чтобы он представлял собой зеркальное отражение текстового фрейма на левой стороне.
Щелкните на пустой области документа, чтобы снять выделение с текстового фрейма, или выберите команду меню Edit › Deselect All (Правка › Отменить все выделение).
Нажмите на клавиатуре клавишу А, чтобы переключиться обратно на инструмент прямого выделения ([image: ]), и щелкните на большом текстовом блоке, расположенном на странице 5. Выделите верхнюю левую точку привязки текстового фрейма и перетащите ее вверх до той же горизонтальной направляющей, которую вы использовали для изменения формы текстового фрейма на левой странице. Можно нажать и удерживать клавишу SHIFT во время перетаскивания, чтобы ограничить перемещения только вертикальным направлением.
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Снимите выделение со всех объектов и затем выберите команду меню File › Save(Файл ›
Сохранить).
Нажатия клавиш А и V для переключения между инструментами выделения и прямого выделения являются лишь двумя из множества клавиатурных команд, доступных в программе InDesign.
Задание 12. Когда вы изменяли размер фрейма с помощью инструмента выделения, фрейм сохранял свою прямоугольную форму. Сейчас вы воспользуетесь инструментом Реn (Перо) и инструментом Direct Selection (Прямое выделение) для изменения формы фрейма.
Нажмите клавишу А, чтобы выбрать инструмент прямого выделения ([image: ]). Затем переместите кончик указателя на край фрейма фиолетового изображения и щелкните левой кнопкой мыши, когда значок указателя отображается с небольшой диагональной линией ([image: ]). В результате выполненных действий выделится путь и отобразятся точки привязки, а также центральная точка фрейма. Оставьте путь выделенным.
Нажмите клавишу Р, чтобы переключиться на инструмент пера, добавляющий точки привязки ([image: ]). Точно позиционируйте указатель на нижнем крае пути фрейма там, где он пересекается с правым полем страницы 4, после этого щелкните левой кнопкой мыши. Добавится новая точка привязки.
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Переместитесь на страницу 5, где нижняя сторона пути пересекается с левым полем страницы, и, используя инструмент пера, добавляющий точку привязки ([image: ]), щелкните еще раз, чтобы добавить еще одну новую точку привязки.
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Нажмите клавишу А, чтобы выбрать инструмент Direct Selection (Прямое выделение). Не снимая выделения со второй новой точки привязки, переместите указатель на первую новую точку привязки (на странице 4 макета) так, чтобы стрелка указателя отображалась с небольшим квадратом ([image: ]). Если левая точка привязки не выделена (отображается в виде полого квадрата), нажмите и удерживайте клавишу SHIFT. затем щелкните, чтобы выделить эту точку привязки. Теперь обе новые точки привязки отображаются в виде закрашенных квадратов; это указывает на то, что они выделены.
Перетаскивайте точки привязки вверх, удерживая нажатой клавишу SHIFT при перетаскивании любой из новых точек привязки или сегмента пути между ними. Когда обе точки привязки зафиксируются на следующей направляющей (в позиции 22р по вертикальной масштабной линейке), отпустите левую кнопку мыши и клавишу SHIFT.
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Теперь размеры и форма рисунка изменены надлежащим образом в соответствии с требуемым дизайном данных страниц.
Нажмите клавишу V, чтобы переключиться на инструмент выделения, и выделите фиолетовый рисунок. Затем выберите команду меню Object › Arrange › Send to Back(Объект › Компоновка › на задний план), чтобы рисунок отображался сзади других элементов на слое Art.
Можно одновременно изменять размеры рисунка и его фрейма, пользуясь инструментом выделения и удерживая нажатыми клавиши CTRL + SHIFT (Windows) в процессе перетаскивания маркеров фрейма. В этом случае при нажатии клавиши SHIFT сохраняются пропорции ограничивающих контуров, так что графическое изображение не будет искажаться. Клавишу SHIFT можно не нажимать, если искажение изображения не критично для проекта.
Цель: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы
1. Создание текстовых фреймов.
2. Перемещение и изменение размеров текстовых фреймов.
3. Изменение свойств текстовых фреймов.
4. Работа с графикой. Расположение графики внутри фрейма.
Задание 1. Выберите команду меню Veiw › Show Gides (Вид › Показать направляющие). Ниже приведет вид страницы до и после включения отображения направляющих.
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Задание 2. Выберите инструмент «Текст» [image: ], а затем, перетаскивая его по странице, задайте ширину и высоту нового текстового фрейма. Если нужно, чтобы фрейм имел квадратную форму, при перетаскивании удерживайте нажатой клавишу «Shift». После отпускания кнопки мыши внутри фрейма появится точка ввода текста. На рисунке ниже показано создание нового текстового фрейма перетаскиванием.
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Выбрав инструмент «Выделение», щелкните входной или выходной порт другого текстового фрейма, а затем щелкните или перетащите его мышью, чтобы создать другой фрейм.
Команда «Поместить» позволяет поместить текстовый файл.
Выбрав инструмент «Текст» [image: ], щелкните внутри любого пустого фрейма. Если в разделе установок «Текст» выбран параметр «Инструмент «Текст» преобразует фреймы в текстовые фреймы», то пустой фрейм преобразуется в текстовый.
Задание 3. Чтобы изменить размер при помощи инструмента «Текст» [image: ], перетащите любой из маркеров фрейма, удерживая нажатой клавишу «Ctrl». Если перед началом перетаскивания удерживать кнопку мыши нажатой в течение одной секунды, то во время изменения размеров фрейма компоновка текста также будет изменяться.
Примечание. Если вместо перетаскивания фрейма щелкнуть его, то выделение текста и позиция точки ввода будут потеряны.
Чтобы изменить размер при помощи инструмента «Выделение» [image: ], перетащите любой из маркеров на рамке фрейма. Чтобы масштабировался текст, находящийся внутри фрейма, удерживайте нажатой клавишу «Ctrl».
Чтобы быстро подогнать размер фрейма под размер его содержимого, выберите текстовый фрейм инструментом «Выделение» и дважды щелкните любой из маркеров. Например, дважды щелкните центральный нижний маркер, и нижняя часть фрейма подтянется к последней строке текста. Если дважды щелкнуть центральный правый маркер, то ширина фрейма уменьшится с учетом заполнения фрейма, а высота останется прежней.
[image: ]
Чтобы подогнать текстовый фрейм под размеры содержимого, выделите фрейм с помощью инструмента «Выделение» и выберите меню «Объект» > «Подгонка» > «Фрейм по размеру содержимого». Нижняя часть текстового фрейма подгоняется по содержащемуся в нем тексту.

Если в текстовом фрейме содержится больше вытесненного текста, чем было бы целесообразно поместить на странице, размеры текстового фрейма остаются неизменными.
Инструмент «Масштабирование» [image: ] позволяет менять размеры фрейма перетаскиванием.
Задание 3. Опишите параметры смещения базовой линии первой строки.
Задание 4. Опишите процесс настройка сетки из базовых линий для текстового фрейма.
Задание 5. Имеется возможность импортирования текста, созданного в отдельном текстовом процессоре, или можно ввести текст, используя средства программы InDesign.
Используя инструмент текста ([image: ]), щелкните и, не отпуская левой кнопки мыши, переместите указатель, чтобы создать текстовый блок для данного заголовка между двумя направляющими под словом "Mexico" в правой колонке на странице.
Если текстовый блок точно не совмещен с направляющими, воспользуйтесь инструментом выделения ([image: ]), чтобы щелкнуть на углах текстового блока и увеличить или уменьшить текстовый блок надлежащим образом.
Введите в текстовый блок строку "Exploring Mexican Folk Art".

[image: ]

В программе InDesign точка ввода текста помещается во фрейм сразу после его создания, поскольку фрейм был создан с помощью инструмента Type (Ввод). Для фреймов, созданных с помощью других инструментов, необходимо вначале щелкнуть внутри фрейма, прежде чем вводить текст.
Выберите фрейм с помощью инструмента выделения ([image: ]).
Выберите команду меню Type › Character (Ввод › Символ).

[image: ]
Выберите на палитре Character (Символ) гарнитуру Adobe Garamond Pro Regular и размер
18 пунктов.
Атрибуты можно применить ко всему тексту в текстовом блоке, выделив этот текстовый блок.

Связывание текста во фреймах
Как правило, текст в программе InDesign помещается во фреймы. Можно добавлять текст в уже существующий фрейм или можно создавать фрейм при импортировании текста.
Задание 6. Проверьте, чтобы не были выбраны другие объекты, и затем выберите команду меню File › Place (Файл › Поместить). Выберите файл.
Указатель принимает форму загруженного текстового значка ([image: ]). При наличии значка загруженного текста доступны несколько вариантов действий: можно перетащить указатель для создания текстового фрейма, щелкнуть внутри существующего фрейма или щелкнуть для создания фрейма в пределах колонки. Добавьте текст в нужную колонку.
Расположите загруженный значок текста в нужном месте, а затем щелкните левой кнопкой мыши.
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Текст перетекает на новое место. Когда в текстовом фрейме находится больше текста, чем может вместить фрейм, во фрейме выводится сообщение об избыточном тексте. На наличие избыточного текста указывает красный символ знака "плюс" (+) на внешней границе фрейма (небольшой квадратик непосредственно над нижним правым углом фрейма). Можно связать избыточный текст с другим фреймом или создать новый фрейм, в который будет перетекать избыточный текст, или расширить размер фрейма.
Если текстовый блок не помещен в левую колонку, щелкните на инструменте выделения ([image: ]) и перетащите маркеры размеров, чтобы переместить текстовый блок в требуемое место.
Щелкните на выходном порту выбранного фрейма.
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Расположите загруженный значок текста в другое место.

[image: ]

Для текстового прямоугольника можно задавать число колонок путем выделения текстового прямоугольника и задания числа колонок на палитре Control (Управление). Это позволяет задавать несколько колонок ввода текста без перетекания текста.

Задание 7. Чтобы улучшить композицию материала, можно добавить врезку.
Выберите команду меню View › Fit Page in Window (Вид › Целая страница). Затем выберите команду меню File › Save (Файл › Сохранить).
В нижнем левом углу окна документа из списка доступных страниц выберите нужную страницу. Если текстовый фрейм врезки не виден, найдите бегунок на линейке прокрутки и перетащите его влево.
Используя инструмент выделения ([image: ]), выделите текстовый фрейм на монтажном столе, который содержит цитату.
Щелкните на палитре Control (Управление), расположенной непосредственно под меню вверху страницы, чтобы ввести значения.
[image: ]

Теперь врезка должна находиться по центру между колонками текста. При необходимости воспользуйтесь клавишами со стрелками, чтобы точно позиционировать фреймы. Низ фрейма должен располагаться на уровне середины красной звезды.
[image: ]

После каждого значения необходимо указывать "in" для идентификации используемых единиц измерения (в нашем случае дюймы). Программа Adobe InDesign позволяет применять в программе, а также в палитрах и диалогах большинство общеупотребительных единиц измерений, для указания которых пользователь должен использовать стандартные сокращения, например "pt" для пунктов или "cm" для обозначения сантиметров.

Задание 9. Находящийся во врезке текст трудно прочитать, поскольку текст основного рассказа не обтекает текстовый фрейм. Вы установите режим обтекания текста основного рассказа вокруг краев текстового фрейма врезки.
Убедитесь, что фрейм врезки выделен.
Выберите команду меню Window › Type & Tables › Text Wrap (Окно › Текст и таблицы ›
Обтекание текста).
На палитре Text Wrap (Обтекание текста) щелкните на третьем режиме обтекания ([image: ]), чтобы текст обтекал вокруг объекта.

[image: ]

Щелкните на кнопке Close (Закрыть), чтобы закрыть палитру Text Wrap (Обтекание текста).

[image: ]

Задание 10. Используя инструмент выделения ([image: ]), выберите изображение луны.

[image: ]


Пользуясь палитрой Control (Управление), выберите значение 50 % в поле X Scale %(масштаб по оси X), которое является верхним из двух значений масштаба на панели управления.

[image: ]


И вертикальный и горизонтальный размеры изменяются пропорционально. Такой режим изменения обусловлен выбором справа от процентных значений масштаба кнопки сохранения пропорций при масштабировании. Можно отменить выделение данной кнопки, если требуется отрегулировать одно из значений независимо от другого. Как правило, растровые изображения, полученные в результате сканирования или с цифровой фотокамеры, должны изменяться пропорционально, причем их размер не должен превышать 120 % исходного размера из-за возможного ухудшения качества. В этом случае мы уменьшили размер изображения, что, как правило, не приводит к ухудшению качества изображения.
Задание 11. Графика, используемая в документах программы InDesign, помещается во фреймы. При работе с графикой, помещенной в документ, используются два инструмента выделения, с которыми следует подробно ознакомиться.
Инструмент   Selection   (Выделение)   ([image: ]) используется для выполнения общих задач размещения, таких как позиционирование и перемещение объектов на странице. Инструмент Direct Selection (Прямое выделение) ([image: ]) применяется для выполнения операций, связанных с содержимым фрейма или рисованием и редактированием путей; например, для выделения содержимого фрейма или для перемещения точки привязки на пути. Инструмент Direct Selection (Прямое выделение) также используется для выделения объектов внутри групп.

Изучая различия между фреймами и их содержимым, возможно, вы захотите сделать края фреймов видимыми с помощью команды меню View › Show Frame edges (Вид › Показать края фреймов).
Расположение графики внутри фрейма
Для двух изображений на первом развороте необходимо изменить размеры их фреймов или изменить внутри фреймов расположение изображений.
Выберите страницу 2 в нижнем левом углу окна документа, чтобы перейти на страницу 2.
Используя   инструмент   прямого   выделения   ([image: ]), щелкните на изображении солнца и удерживайте левую кнопку мыши нажатой. Перетащите изображение в центр фрейма так, чтобы был видим весь рисунок солнца.

[image: ]

С помощью инструмента Direct Selection (Прямое выделение) можно изменять положение графики внутри фрейма.
Используя инструмент выделения ([image: ]), щелкните па изображении синей руки.
[image: ]Щелкните и, не отпуская левой кнопки мыши, перетащите центральный маркер вверх, чтобы увеличить размер фрейма.

При перемещении фрейма и изменении его размеров можно просматривать изображение. Для этого следует сделать кратковременную паузу, прежде чем изменять размер изображения или перемещать его.


ПРАКТИЧЕСКАЯ РАБОТА 2

Цель: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы
1. Создание буквицы в InDesign.
2. Оформление эпиграфа.
3. Оформление примечания.
4. Оформление аннотаций.
Задание 1. Выделим абзац, который должен начинаться с буквицы.

[image: ]

В меню Window (Окно) – Type (Шрифт) откроем палитру Paragraph (Абзац), горячая клавиша Ctrl+M. Зададим количество строк буквицы, к примеру 5, в поле "Drop Cap Number of Lines" (Буквица Количество Строк). Если хотите изменить гарнитуру буквицы, выделите ее и просто выберите другой шрифт. Также можете поэкспериментировать с полями настройки буквицы для изменения ее внешнего вида.
[image: ]
Задание 2. Функция «Примечания» программы InDesign использует для идентификации автора примечания или отслеженного изменения имен пользователей, участвующих в рабочих процессах. Примечания и отслеживаемые изменения каждого пользователя помечаются цветовым кодом, как указано в параметрах примечаний в программе InDesign или в диалоговом окне
«Пользователь» в InCopy («Файл» – «Пользователь»).
Примечания отображаются только в тексте. В программе InDesign их можно напечатать только из редактора материала и нельзя экспортировать в PDF.

При добавлении редакционных примечаний в управляемое содержимое в программе InDesign эти примечания становятся доступными для других участников рабочего процесса. В первую очередь примечания предназначаются для использования в рабочем процессе InCopy, но ими также можно пользоваться в InDesign. Например, в примечаниях можно поместить текст, который предполагается добавить в материал впоследствии. В InCopy примечания можно конвертировать в формат PDF при экспорте в файл Adobe PDF.
С помощью инструмента «Текст» щелкните место, в котором нужно поместить примечание, и выберите пункт «Текст» – «Примечания» – «Создать примечание».
При работе в редакторе материала отображаются форзацы примечаний. В режиме «Макет» отображается палитра «Примечания».
Введите текст примечания между форзацами или в палитре «Примечания».
В любом месте можно добавить любое число примечаний. Однако нельзя создавать примечание внутри другого примечания.
Чтобы отобразить или скрыть примечания, выберите «Просмотр» – «Вспомогательные элементы» – «Показать примечания» или «Скрыть примечания».
Добавьте несколько примечания к заданному тексту. Просмотрите созданные примечания. Преобразуйте в примечание произвольную часть текста. Выполните обратное действие.
[image: ]Задание 3. Концевая сноска состоит из двух связанных частей: номер концевой сноски (в исходном тексте) и текст концевой сноски (отображается в новом фрейме в конце документа). В левом нижнем углу фрейма концевой сноски отображается графическое украшение .
Предусмотрена возможность создания концевых сносок и их импорта из документов Word. Концевые сноски автоматически нумеруются по мере их добавления в документ. Есть возможность управлять стилем нумерации, внешним видом и макетом концевых сносок. Кроме того, нумерация автоматически настраивается при изменении порядка концевых сносок в тексте. Концевые сноски можно также добавлять в таблицы.
[image: ]
Поместите точку ввода в то место, где должен находиться номер концевой сноски. Выполните одно из следующих действий:
Нажмите правой кнопкой мыши и выберите Вставить концевую сноску. Выберите Текст – Вставить концевую сноску.
Введите текст концевой сноски.
Задание 4. Добавление примечания о продолжении страницы.

Поскольку рассказ на странице 2 связан с другой страницей, можно сообщить читателям о том, где следует возобновить чтение, когда они прочитают статью до конца страницы. Чтобы сделать это, вы добавите фрейм (Continued on page x). Можно добавить автоматический номер страницы, который будет автоматически показывать номер следующей страницы в текстовом потоке.
Отцентрируйте страницу 2 в окне документа посредством прокрутки или с помощью палитры
Pages (Страницы).
Перетащите направляющую с  горизонтальной  масштабной линейки вниз  на  отметку  46р.
Увеличьте масштаб отображения, чтобы можно было легко читать текст в колонке.
Выберите инструмент выделения ( [image: ] ), щелкните на текстовом фрейме в правой колонке на странице 2 и перетащите нижний средний маркер вверх до направляющей 46р.
[image: ]


[image: ]Выберите инструмент ввода ( ), щелкните и, не отпуская левой кнопки мыши, переместите указатель, чтобы создать текстовый фрейм, который заполнит пространство внизу самой правой колонки на странице 2.
Установив активную точку ввода в новом текстовом фрейме, наберите (Continued on page), включая пробелы и круглые скобки. Затем воспользуйтесь клавишей со стрелкой, направленной влево, чтобы переместить точку ввода в позицию слева от закрывающей скобки.
Щелкните на текстовом фрейме правой кнопкой мыши (Windows) и в появившемся контекстном меню выберите команду Insert Special Character › Next Page Number (Вставить спецсимвол › Номер следующей страницы). Теперь отображается текст (Continued on page 4).
Текстовый фрейм, содержащий заголовок продолжения, должен касаться связанного текста фрейма или перекрывать его, чтобы символ Next Page Number("Номер следующей страницы") действовал надлежащим образом.

При необходимости выберите инструмент выделения и перетащите вверх верхнюю границу текстового фрейма, чтобы она привязалась к текстовому фрейму, расположенному выше.
[image: ]

Используя инструмент Selection (Выделение), щелкните на текстовом фрейме заголовка продолжения и затем при нажатой клавише SHIFT щелкните на текстовом фрейме, расположенном непосредственно над текстовым фреймом заголовка продолжения. Затем выберите команду меню Object › Group (Объект › Сгруппировать). Это позволит перемещать рассказ и заголовок продолжения как одно целое.


ПРАКТИЧЕСКАЯ РАБОТА 3

Цель: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы
1. Цветной и оттеночный цвет.
2. Книжная верстка.
3. Печать документа или книги.
4. Параметры печати страницы.
Задание 1. Как и в случае фреймов, обводку и заливку можно применять и к тексту. Вы примените цвета к тексту, находящемуся внутри фреймов на странице 2 документа.
В палитре Pages (Страницы) дважды щелкните на значке страницы 2, чтобы отобразить страницу 2 по центру окна документа.
Используя инструмент выделения ([image: ]), щелкните на слове "Origami", чтобы выделить заголовок.
Убедитесь, что на панели инструментов выбрана кнопка заливки ([image: ]), и затем щелкните на небольшом значке буквы ([image: ]) (форматирование воздействует на текст), расположенном в ряду под кнопкой Fill (Заливка).

[image: ]

В палитре Swatches (Образцы цвета) щелкните на цвете PANTONE 876 М, а затем щелкните на пустой области, чтобы снять выделение. Теперь текст окрасится в плашечный цвет.
Возможно, на мониторе текст отображается окрашенным в скучный бурый оттенок, но реальный отпечатанный цвет текста будет плашечным цветом металлик. Далее вы вставите еще один текстовый фрейм и примените цвета к тексту.
Выберите инструмент ввода ([image: ]) и  трижды щелкните на  фразе "a  short  story by" внизу страницы, чтобы выделить этот абзац.
Убедитесь, что на панели инструментов выбрана кнопка заливки ([image: ]), и затем щелкните на цвете Purple (Пурпурный).
Трижды щелкните на фразе Clyde Bell, чтобы выделить имя, и затем щелкните в палитре
Swatches (Образцы цвета) на цвете Red (Красный).
Выберите команду меню Edit › Deselect All (Правка › Отменить все выделение), чтобы увидеть цветной текст. Затем выберите команду меню File › Save (Файл › Сохранить).
Задание 2. Вы можете создать текст, который располагается вдоль края открытого или закрытого пути любой формы.
Используя инструмент выделения ( [image: ] ), щелкните на рисунке, расположенном над фразой "It's Mr. Tuneup". Обратите внимание на центральную точку рисунка. Вы воспользуетесь этой центральной точкой при рисовании окружности.
Щелкните на инструменте Rectangle (Прямоугольник) на панели инструментов и, не отпуская левой кнопки мыши, выберите инструмент эллипса ([image: ]). Убедитесь, что на панели инструментов для кнопки заливки установлен режим None (Нет).
Нажмите и удерживайте нажатой комбинацию клавиш ALT + SHIFT (Windows), расположите указатель на центральной точке рисунка и перетащите указатель наружу, чтобы создать окружность чуть большую, чем рисунок Самоделкина (со значениями W и Н около 19 пика в палитре Transform(Трансформация)).

[image: ]

При нажатии и удерживании клавиши SHIFT инструментом эллипса рисуется окружность; при нажатии клавиши ALT или Option начальная точка становится центром рисунка, так что фигура рисуется перетаскиванием указателя от центра.
Используя инструмент ввода ([image: ]), выделите под рисунком первые две строки: "It's Mr.
Tuneup! The Maestro Mechanic of Sonata Cycles".
Выберите команду меню Edit › Copy (Правка › Копировать).
Щелкните на инструменте Type (Ввод) на панели инструментов и, не отпуская левой кнопки мыши, выберите инструмент Path Type (Ввод на пути) ([image: ]).
Расположите указатель на верхней левой части окружности так, чтобы рядом с указателем
[image: ]появился небольшой знак плюса ( ), щелкните и, не отпуская левой кнопки мыши, переместите указатель на другую сторону окружности.
Если установить точку ввода на пути посредством щелчка, текст будет располагаться вдоль всего пути. Если перетащить указатель, текст появится только вдоль дуги, заданной посредством перетаскивания указателя.
Выберите команду меню Edit › Paste (Правка › Вставить).

[image: ]

Знак плюс (+) в выходном порту в конце текста на пути указывает на наличие избыточного неразмещенного текста. Чтобы отобразить весь текст на пути, вы отрегулируете индикаторы начала и конца текста на пути, которые представляют собой синие линии, появляющиеся до и после вставленного текста.

[image: ]Выберите инструмент прямого выделения ([image: ]) и переместите его на синий индикатор в начале пути текста. При надлежащем размещении указателя инструмента Direct Selection (Прямое выделение) он отображается в виде сплошной стрелки с небольшим вертикальным отрезком прямой линии и знаком плюс ( ).
Перетащите линию индикатора начала (а не входной порт) ниже левого центрального маркера окружности. Затем перетащите линию индикатора конца (а не выходной порт) вниз так, чтобы на экране появился весь текст.
[image: ]

Задание 3. Применение к тексту градиента. В программе InDesign очень просто применять градиенты к заливке и обводке символов текста. Градиенты можно применить ко всему текстовому фрейму или к разным диапазонам символов внутри фрейма. Здесь вы примените градиент к врезке на странице 2. Вы воспользуетесь образцом градиента, который был создан и добавлен ранее на палитру Swatches (Образцы цвета).
Щелкните на вкладке палитры Swatches (Образцы цвета) или выберите команду меню Window
› Swatches (Окно › Образцы цвета), чтобы сделать палитру видимой.

[image: ]


[image: ]Убедитесь, что по-прежнему выбран инструмент ввода (	). Щелкните в тексте врезки на странице 2 и затем выделите весь текст абзаца.

Выберите кнопку заливки ([image: ]) на панели инструментов и затем выберите образец градиента текста на палитре Swatches (Образцы цвета) (возможно, потребуется прокрутить окно палитры). Чтобы просмотреть градиент, выберите команду меню Edit › Deselect All (Правка › Отменить все выделение).
Обратите внимание, как градиент изменяется слева направо. Если требуется изменить направление градиента, можно воспользоваться инструментом градиента. Вы выполните эту операцию сейчас, установив направление градиента сверху вниз на врезке, расположенной на странице 3.

[image: ]


При применении образца градиента к выделенному тексту создается градиентная заливка в направлении слева направо.
Используя инструмент Type (Ввод), повторно выделите весь текст во врезке.
Выберите инструмент градиента (а не кнопку градиента) на панели инструментов ([image: ]) и перетащите линию сверху вниз подсвеченного текста. Чтобы гарантированно нарисовать прямую линию, нажмите и в процессе перетаскивания удерживайте нажатой клавишу SHIFT.
[image: ]

Инструмент градиента (слева) позволяет устанавливать направление градиентной заливки.
Чтобы просмотреть градиентную заливку, вы воспользуетесь комбинацией клавиш для снятия выделения со всего текста.
Нажмите комбинацию клавиш SHIFT + CTRL + A (Windows), чтобы снять выделение с текста.
Выберите команду меню File › Save (Файл › Сохранить).
Задание 4. Книжная верстка.
Создание файла, перенос текста.
File – New. Создать новый файл, указать формат страницы, поля, количество страниц (отличное от 1), галочка в окошке “Facing pages” (разворот).
Открыть документ Word. Ctrl+A (выделить все), Ctrl+C.
Перейти в InDesign. Выбрать инструмент «Техт». При нажатой ЛКМ создать на странице текстовый фрейм. Ctrl+V.
Выбрать инструмент «стрелка», выделить фрейм. Щелкнуть на красном плюсе в правом нижнем углу фрейма. Перейти на с. 2, Shift+ЛКМ на странице.
Создание колонтитулов
Инструментом «Текст» создать верхний колонтитул (напр., название книги), фрейм для нижнего колонтитула. ЛКМ во фрейме, Type – Insert Special Charater – Markers – Current Page Number (создать нумерацию страниц).
Инструментом «стрелка» выделить верхний и нижний колонтитулы, скопировать и вставить на второй лист разворота.
Если на каких-то страницах элементы мастер-страницы не нужны (например, титульный лист), F12, выделить нужную страницу (ЛКМ – выделить разворот, 2ЛКМ – выделить отдельную страницу), ПКМ – Override All Master Page Items.
Инструментом «стрелка» выделить на странице ненужные элементы, удалить.
Создание вспомогательных инструментов
Открыть панель Paragraph Styles (создание стиля параграфа). Кнопка Create New Style. 2ЛКМ на Paragraph Style. Переименовываем в «Основной текст». Задаем параметры основного текста книги.
Пункт Basic Character Formats – гарнитура, кегль, начертание. Окно Leading – это те самые
«интервалы», значение в скобках указывает, что оно выбрано автоматически по стандарту, менять только в случае необходимости.
Пункт Advanced Character Formats – меняем Language на Russian для корректной работы с переносами.
Пункт Indents and Spacing – параметры абзаца (отступы, выключка (для основного текста выбрать Left Justify – выключка по формату, последняя строка по левому краю), First Line – красная строка).
Пункт Hyphenation – переносы, включены все галочки.
Создать стиль «Заголовок» по той же схеме. На основе стилей впоследствии автоматически формируется оглавление.
При наличии подзаголовков, подписей к иллюстрациям и т.п. создать стили для каждой разновидности.
Если в тексте много выделений курсивом или полужирным начертанием, присутствуют, например, греческие символы, необходимо создать стили символов. Для этого открываем меню Character Styles. Создаем необходимые стили по такой же схеме, как и для абзацев.

Разница между этими стилями в том, что стиль абзаца применяется к абзацу, в котором находится курсор, или к выделенным абзацам, а стиль символа – к выделенным символам.
Верстка иллюстраций
Иллюстрации, жестко привязанные к месту в тексте. Ctrl+D (Place), Ctrl+X, инструмент
«текст», щелкнуть в нужном месте текста, Ctrl+V.
Иллюстрации, привязанные к месту на странице. Ctrl+D, инструмент «стрелка», разместить в нужном месте, создать «обтекание текстом», чтобы картинка не закрывала текст.
Для этого открываем меню Text Wrap.
Выделяем изображение.
Выбираем тип обтекания (со всех сторон, сверху и снизу, сверху, по фигурному контуру (лучше не пользоваться, т.к. требует иллюстрации с заданным «путем» (делается в Photoshop»)) и отступы текста от изображения.
Создание оглавления
Layout – Table of Contents.
В списке справа выбираем стиль, обозначающий пункты, которые должны войти в оглавление (например, Заголовок, Подзаголовок). Автоматически генерируется оглавление с нумерацией страниц.
Задание 5. Убедитесь, что для используемого принтера правильно установлен драйвер и PPD-
файл.
Откройте диалоговое окно «Печать».
Если отдельные документы уже открыты, выберите «Файл» > «Печать». Открывается диалоговое окно «Печать» для текущего документа.
Если нет документов или все они выделены на палитре «Книга», выберите «Печатать книгу» в меню палитры «Книга». Это позволит напечатать все документы книги.
Если несколько документов выделено на палитре «Книга», выберите команду «Печатать выделенные документы» в меню палитры «Книга».
Укажите используемый принтер в меню «Принтер». Если для печатающего устройства имеется стиль, содержащий все необходимые установки, выберите его в меню «Стили печати».
В области «Основные» задайте количество копий для печати, выберите, упорядочивать страницы или печатать их в обратном порядке; и укажите, какие страницы нужно распечатать.
Параметр «Диапазон» недоступен при печати книги.
При печати документа, в котором содержатся страницы разных форматов, воспользуйтесь элементами управления, расположенными над полем «Диапазон», чтобы выбрать диапазон страниц одного формата.
Укажите, нужно ли печатать непечатаемые объекты, пустые страницы, видимые направляющие или сетки из базовых линий.
Настройте параметры согласно требованиям для каждой области диалогового окна «Печать». Нажмите кнопку «Печать».
Параметры, заданные в диалоговом окне «Печать», сохраняются вместе с документом.
Задание 6. На панели «Страницы» выберите один из следующих элементов:
· выберите одну страницу;
· выберите несколько страниц;
· выберите страницу-шаблон;
· выберите разворот.

Щелкните выделенный фрагмент правой кнопкой мыши и выберите «Печать страницы» или
«Печать разворота» (в зависимости от выбранного параметра).
Либо выберите «Печать страницы» или «Печать разворота» во всплывающем меню панели
«Страницы».
Отображается диалоговое окно «Печать» с выбранной страницей или диапазоном страниц. Нажмите «Печать».
Задание 7. Опишите параметры печати страницы.


	Диапазон
	

	Последовательность
	

	Развороты
	



Задание 8. Опишите параметры печати объектов.


	Печатать слои
	

	Печатать непечатаемые объекты
	

	Печатать пустые страницы
	

	Видимые направляющие и базовые линии
	




Цель: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы
1. Добавление цветов в палитру Swatches
2. Создание оттенков цветов.
3. Создание градиентов.
[image: ]Задание 1. Выберите кнопку заливки (	), чтобы любые выполняемые действия затрагивали только центральную часть объекта, оставляя обводку объекта без изменений.
[image: ]

[image: ][image: ][image: ]Щелкните на кнопке Color (Цвет) ( ), расположенной на панели инструментов. Объект зальется сплошным черным цветом. Щелкните на прямоугольнике Gradient (Градиент) ( ). Объект зальется черно-белой градиентной заливкой. Щелкните на прямоугольнике None(Отсутствует) ( ), чтобы вернуть объект к исходному состоянию без заливки. Ниже на рисунке представлен объект, заполненный сплошным черным цветом (слева), заполненный градиентной заливкой (в центре) и без заполнения (справа).

[image: ]


Если вы случайно дважды щелкнули на кнопке Fill (Заливка) или на кнопке Gradient(Градиент), откроется палитра Color (Цвет) или Gradient (Градиент).
При запуске программы InDesign несколько групп палитр свернуты в виде вкладок, расположенных сбоку программного окна (Windows). Свернутые палитры можно разворачивать в их собственные окна или сворачивать другие палитры в виде боковых вкладок. Палитры, свернутые в боковые вкладки, можно группировать и изменять их размещение.
Отображение свернутой палитры: щелкните на вкладке палитры, чтобы отобразить или скрыть палитру.
Преобразование свернутой палитры в плавающую палитру: перетащите вкладку палитры с боковой стороны программного окна (Windows).
[image: ]Свертывание палитры во вкладку, расположенную сбоку: щелкните на вкладке палитры и, не отпуская левой кнопки мыши, переместите палитру к левой или правой стороне программного окна (Windows).
Теперь выберите кнопку Stroke (Обводка) ( )с тем, чтобы выполняемое редактирование затрагивало только обводку объекта.
[image: ]

[image: ][image: ]Щелкните на кнопке Gradient (Градиент) ( ), расположенной на панели инструментов. Сплошная обводка превратится в градиентную обводку. Щелкните на кнопке Color (Цвет) ( ), чтобы вернуть объекту его исходную обводку. Затем щелкните на пустой области страницы или на монтажном столе, чтобы снять выделение с изображения облака.
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Задание 2. Добавлять к объекту цвет можно с помощью комбинации палитр и инструментов. Технология работы с цветом в программе InDesign основана на функциональных возможностях палитры Swatches (Образцы цвета). Использование палитры Swatches (Образцы цвета) для именования цветов облегчает применение, редактирование и обновление цветов объектов в документе. Хотя для применения цветов к объектам также можно использовать палитру Color (Цвет), в этом случае нельзя быстро обновить примененные цвета, называемые безымянными цветами. Вместо этого необходимо обновлять цвет каждого объекта отдельно.
Сейчас вы создадите большинство цветов, которые будут использоваться в данном документе. Поскольку этот документ предназначен для печати в типографии, вы будете создавать компонентные CMYK-цвета.
Убедитесь, что никакие объекты не выделены, и затем щелкните на вкладке палитры Swatches (Образцы цвета). (Если палитры Swatches (Образцы цвета) не видно на экране, выберите команду меню Window › Swatches (Окно › Образцы цвета).)
В палитре Swatches (Образцы цвета) хранятся цвета, которые были предварительно загружены в программу InDesign, а также цвета, оттенки и градиенты, созданные пользователем и сохраненные для повторного применения.
Выберите в меню палитры Swatches (Образцы цвета) команду New Color Swatch (Новый образец цвета).
Сбросьте флажок Name With Color Value (Именовать кодом цвета) и введите в поле Swatch Name (Имя образца цвета) название Purple. Убедитесь, что в открывающемся списке Color Type (Тип цвета) установлено значение Process (Компонентный), а в открывающемся списке Color Mode (Цветовой режим) – CMYK.
Когда установлен флажок Name With Color Value (Именовать кодом цвета), цвету присваивается имя в виде кодовых значений CMYK, которые вводятся пользователем, и имя автоматически обновляется при изменении компонентов цвета. Данный режим доступен только для компонентных цветов и удобен, когда требуется использовать палитру Swatches (Образцы цвета) для контроля точного состава образцов компонентных CMYK-цветов.
В поля процентов цветовых компонентов введите следующие значения: С = 67, М = 74, Y = 19
[image: ]и В = 12, а затем щелкните на кнопке ОК.

Повторите предыдущие три шага, чтобы присвоить имена и создать следующие цвета.


	
	С
	М
	Y
	К

	Red (Красный)
	0
	69
	60
	12

	Green (Зеленый)
	51
	19
	91
	12

	Gold (Золотистый)
	0
	31
	81
	4



Если вы забыли ввести имя для цвета или если введено неправильное значение, дважды щелкните на образце цвета, измените имя или значение, а затем щелкните на кнопке ОК.
Новые цвета, добавляемые в палитру Swatches (Образцы цвета), хранятся только с документом, в котором они были созданы. Вы примените эти цвета в документе к тексту, рисункам и фреймам.
Задание 3. Кроме добавления цветов на палитру Swatches (Образцы цвета) можно также добавлять оттенки.
Оттенок – это растрированная (более светлая) версия цвета.
Оттенки полезны, так как программа InDesign сохраняет соотношение между оттенком и его родительским цветом. Например, если бы вы изменили образец цвета Green (Зеленый) на другой цвет, образец оттенка, который вы создадите в этой процедуре, стал бы более светлой версией нового цвета.
Снимите выделение со всех объектов.
Щелкните на цвете Green (Зеленый) на палитре Swatches (Образцы цвета). Выберите в меню палитры Swatches (Образцы цвета) команду New Tint Swatch (Новый образец оттенка). Введите в поле Tint (Оттенок) процентное значение 30 и щелкните на кнопке ОК.
[image: ]

В конце списка образцов появится новый образец оттенка. Вверху палитры Swatches (Образцы цвета) отображаются данные о выбранном образце: кнопка Fill/Stroke (Заливка/Обводка) показывает, что зеленый оттенок выбран в текущий момент в качестве цвета заливки, а в поле Tint (Оттенок) отображается 30 – процент исходного цвета Green (Зеленый).

Выберите команду меню View › Fit Page in Window (Вид › Целая страница), чтобы отобразить по центру окна документа правую страницу разворота. Используя инструмент выделения ([image: ]), щелкните на текстовом фрейме вставки в правой части страницы.
Убедитесь, что кнопка заливки ([image: ]) выбрана, и затем щелкните на оттенке зеленого цвета, который вы только что создали в палитре Swatches (Образцы цвета).

[image: ]

Вид страницы до и после добавления оттенка заливки.


ПРАКТИЧЕСКАЯ РАБОТА 4

Цель: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы
1. Создание различных объектов.
2. Комбинирование и моделирование объектов.
3. Обтекание текста вокруг графики.
4. Размещение импортированной графики в текст.
Задание 1. Выберите объект.
Щелкните по пиктограмме None на панели инструментов или в палитре Swatches либо Color.

[image: ]

Если объект расположен на заднем плане, вы не сможете увидеть различия между белой заливкой и незаполненным объекта. Для этого проверьте пиктограмму на панели инструментов или в палитре Swatche либо Color.
Другой способ преобразования объектов состоит в том, чтобы создать составной контур. Он позволяет одному объекту "пробить" отверстие в другом. То есть внутренний контур получается прозрачным, а внешний контур остается сплошным.
[image: ]

Создание составного контура
1. Выберите два объекта.
2. Выполните команды Object › Comp und Paths › Make (Элемент › Составные контуры ›
Создать).
Если второй объект находится внутри первого, отверстие появится в месте наложения объектов.
Составные контуры должны содержать одинаковые фоновую заливку и контурную линию. Вы можете освободить отдельные объекты от эффекта составного контура, чтобы восстановить сплошной цвет внутреннего объекта.
Освобождение объектов от составного контура
Выберите составной контур.
Выполните команды Object › Compound Paths › Release (Объект › Составные контуры ›
Освободить).
Задание 2. Программа InDesign облегчает процесс изменения параметров фона и контуров объектов.
[image: ]
Щелкните по двунаправленной изогнутой стрелке на панели инструментов. Будет включена опция либо заполнения, либо обрамления выбранного объекта.
Вы можете обрамлять внешние границы текста цветом или градиентом.

Задание 3. Преобразование отверстий в составном контуре в области для заливки.
От направления каждого из подконтуров (от того, в какой последовательности создавались точки подконтура) зависит, находится определяемая им область внутри (области, заполняемые заливкой) или снаружи (пустые области). Если в составном контуре отсутствуют ожидаемые отверстия, можно изменить направление соответствующего подконтура на противоположное.
[image: ]
Два отдельных замкнутых контура (слева) и два подконтура того же составного контура (справа). В составном контуре в качестве отверстия используется центральная окружность.
С помощью инструмента «Частичное выделение» [image: ] выделите часть составного контура (или точку на этой части), чтобы изменить его направление на противоположное. Не выделяйте весь составной контур.
Выполните одно из следующих действий:
Выберите «Объект» > «Контуры» > «Изменить направление контура».
Нажмите кнопку «Изменить направление контура» в палитре «Обработка контуров».
Задание 4. Создание составных фигур.
Составные фигуры создаются с помощью палитры «Обработка контуров» («ОКно» >
«Объекты и макет» > «Обработка контуров»). Составные фигуры могут создаваться из простых или составных контуров, текстовых фреймов, текста, преобразованного в кривые, и других фигур. Внешний вид составной фигуры зависит от того, какая кнопка панели «Обработка контуров» была выбрана. На рисунке ниже показана палитра «Обработка контуров» (A. Исходные объекты. B. Добавить. C. Вычитание. D. Пересечение. E. Исключить наложение. F. Минус нижний).
[image: ]
Добавить
Прослеживает кривые всех объектов для создания одной фигуры.
Вычитание

Объекты в передних «пробитых отверстиях» в объекте, расположенном позади всех остальных.
Пересечение
Создает фигуру на основе перекрывающихся областей.
Исключить наложение
Создает фигуру на основе областей, которые не перекрываются.
Минус нижний
Объекты в задних «пробитых отверстиях» в объекте, расположенном впереди всех остальных. В большинстве случаев результирующая фигура получает атрибуты (заливка, обводка,
прозрачность, слой и т.д.) объекта, расположенного впереди всех остальных. Но при вычитании фигур объекты, расположенные спереди, удаляются. Вместо этого результирующая фигура примет атрибуты объекта, расположенного позади всех остальных.
При включении текстового фрейма в составную фигуру его форма изменяется, но сам текст остается прежним. Для изменения самого текста следует создавать составные контуры с использованием кривых. Ниже показана составная фигура, используемая в качестве текстового фрейма (слева) и созданная на основе кривых (справа)
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Создайте составные фигуры.
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Задание 5. Создание контуров на основе кривых.
Команда «Создать кривые» позволяет преобразовать выделенные символы текста в ряд составных контуров, доступных для редактирования и обработки. Эта команда может применяться для создания эффектов в крупном шрифте, однако она редко применяется для основного или другого текста со шрифтами меньших размеров.
Команда «Создать кривые» получает необходимую информацию о кривых шрифта непосредственно из файлов Type 1, TrueType или OpenType. При этом символы преобразуются в своих текущих позициях, сохраняя все графическое форматирование (обводку, заливку и др.).

Когда шрифт преобразуется в кривые, он теряет свои подсказки – инструкции по корректировке формы, встроенные в контурные шрифты и позволяющие системе оптимизировать отображение и печать текста при небольших размерах символов. Поэтому может оказаться, что преобразованный в кривые шрифт отображается недостаточно качественно при его рендеринге с малыми размерами символов или в низком разрешении.
После преобразования шрифта в кривые можно выполнить одно из следующих действий.
Изменить	графические	фигуры,	перетаскивая	отдельные	опорные	точки	с	помощью инструмента «Частичное выделение» [image: ].
Скопируйте кривые и используйте команду «Редактирование» > «Вставить в», чтобы маскировать изображение и вставить его в преобразованные кривые.
Воспользуйтесь преобразованными кривыми в качестве текстовых фреймов, чтобы можно было вводить или помещать в них текст.
Измените атрибуты обводки букв.
Текст, преобразованный в кривые, подходит для создания составных фигур. Создайте контуры на основе кривых.
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Задание 6. Имеется возможность настройки обтекания текста вокруг фрейма объекта или вокруг самого объекта. В этой процедуре вы увидите разницу между обтеканием текста вокруг ограничивающего контура и обтеканием текста вокруг рисунка.
Первая задача состоит в перемещении рисунка и не вызывает никаких трудностей; рисунок просто выделяется и перетаскивается. Для точного позиционирования фрейма можно также использовать клавиши со стрелками или можно ввести точные координаты позиции на палитре Transform (Трансформация).
Используя   инструмент   выделения   ([image: ]), выделите восьмиточечный фрейм рисунка с изображением бумажного журавля, который находится на странице 4. Обращая внимание, чтобы не выделить какой-либо из маркеров, переместите фрейм вниз так, чтобы верх рисунка зафиксировался на следующей нижней направляющей, расположенной в позиции 42 пика по вертикальной масштабной шкале. Убедитесь, что центральная точка рисунка совмещена с серединой зазора между двумя колонками текста. Размеры фрейма должны остаться без изменения, а сам фрейм должен быть перемещен на странице.
Обратите внимание, что текст отображается сверху рисунка. Вы устраните этот недостаток, установив режим обтекания текста.
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Выберите команду меню Window › Type & Tables › Text Wrap (Окно › Текст и таблицы › Обтекание текста), чтобы открыть палитру Text Wrap (Обтекание текста), и выберите второй режим обтекания, в котором текст обтекает вокруг ограничивающего контура, а не вокруг звездообразного фрейма. Ниже показан текст, обтекающий вокруг ограничивающего контура.
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Затем выберите третий режим обтекания, чтобы текст обтекал вокруг контура фрейма рисунка, а не вокруг ограничивающего контура. Щелкните на пустой области, чтобы снять выделение со всех объектов. На рисунке ниже показан текст, обтекающий содержимое.
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ПРАКТИЧЕСКАЯ РАБОТА 5

Цель: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы
1. Создание таблиц.
2. Добавление текста и графики в таблицу.
3. Работа со строками и столбцами.
4. Вставка строк и столбцов.
5. Удаление строк, столбцов и таблиц.
6. Изменение выравнивания таблицы внутри фрейма.
7. Форматирование таблиц.
Задание 1. В InDesign есть возможность создавать таблицы в существующем текстовом фрейме (Использование параметра «Вставить таблицу»). Кроме того, можно создать таблицу и позволить InDesign создать текстовый фрейм вокруг нее (использование параметра «Создать таблицу»).
Использование параметра «Вставить таблицу»
Чтобы создать таблицу в существующем текстовом фрейме, используйте инструмент «Текст» [image: ]и поместите точку ввода в том месте, где необходимо создать таблицу.
Выберите команды «Таблица» > «Вставить таблицу».
Примечание. Если в данный момент курсор находится за пределами текстового фрейма, доступен параметр «Создать таблицу».
Укажите число строк и столбцов.
Если содержимое таблицы должно располагаться в нескольких столбцах или фреймах, задайте количество строк для верхних и нижних колонтитулов, информация в которых должна повторяться.
Задайте стиль таблицы. Нажмите кнопку «ОК».
Новая таблица располагается по всей ширине текстового фрейма.
Использование параметра «Создать таблицу»
При использовании параметра «Создать таблицу» нет необходимости сначала создавать текстовый фрейм в документе. После того как вы создадите таблицу в документе, будет создан текстовый фрейм по размеру этой таблицы.
Выберите команды «Таблица» > «Создать таблицу».
Примечание. Если в данный момент курсор находится в текстовом фрейме, доступен параметр
«Вставить таблицу».
Укажите число строк и столбцов.
Если содержимое таблицы должно располагаться в нескольких столбцах или фреймах, задайте количество строк для верхних и нижних колонтитулов, информация в которых должна повторяться.
Задайте стиль таблицы. Нажмите кнопку «ОК».

С помощью курсора создайте нужную таблицу.
InDesign создает текстовый фрейм по размеру очерченной области и создает таблицу в текстовом фрейме.
Высота строки таблицы определяется выбранным стилем таблицы. Например, для форматирования различных частей таблицы могут использоваться различные стили ячеек, определенные в стиле таблицы. Если стили ячеек содержат стили абзацев, то высота строки в этой области будет определяться значением интерлиньяжа в стиле абзаца. Если стили абзацев не используются, то высота строки определяется значением служебного поля по умолчанию в документе. Служебное поле определяется значением интерлиньяжа. В данном контексте служебное поле примерно равно высоте подсветки выделенного текста.
Создание таблицы из существующего текста
Перед преобразованием текста в таблицу убедитесь, что он соответствующим образом подготовлен.
Подготовка текста к преобразованию включает в себя расстановку символов начала нового абзаца, табуляторов, запятых или других символов, разделяющих столбцы. Строки разделяются табуляторами, запятыми, символами начала нового абзаца или другими символами. (Во многих случаях текст можно преобразовать в таблицу без дополнительной подготовки.)
Выберите инструмент «Текст» [image: ]   и выделите текст, который необходимо преобразовать в таблицу.
Выберите команды «Таблица» > «Преобразовать текст в таблицу».
В полях «Разделитель столбцов» и «Разделитель строк» задайте, где должны начинаться строки и столбцы. Для этого выберите «Tab», «Запятая» или «Абзац», либо введите другой символ (например, точку с запятой). (Любой введенный символ будет отображаться в меню в следующий раз при создании таблицы из текста).
Если для столбцов и строк задан один и тот же разделитель, укажите количество столбцов создаваемой таблицы.
Задайте стиль таблицы для форматирования. Нажмите кнопку «ОК».
Если в какой-либо строке элементов меньше, чем столбцов в таблице, то оставшиеся ячейки будут пустыми.
Встраивание одной таблицы в другую
Выполните одно из следующих действий:
Выделите ячейки или таблицу для встраивания в другую таблицу, затем выберите команду
«Редактирование» > «Вырезать» или «Скопировать». Поместите точку ввода в ячейку, куда должна быть вставлена таблица, затем выберите команду «Редактирование» > «Вставить».
Щелкните на ячейке, выберите команду «Таблица» > «Вставить таблицу», задайте число строк и столбцов, затем нажмите кнопку «ОК».
При необходимости настройте отступ ячеек.
При создании таблицы в ячейке нельзя выделить мышью часть таблицы за пределами ячейки. В этом случае необходимо расширить строку или столбец либо поместить точку ввода в первую часть таблицы, а затем при помощи комбинаций клавиш переместить точку ввода и выделить текст.
Импорт таблиц из других приложений

При импорте электронной таблицы Microsoft Excel или документа Microsoft Word с таблицами с помощью команды «Поместить» данные импортируются в виде таблицы, доступной для редактирования. Форматирование настраивается в диалоговом окне «Параметры импорта».
Кроме того, данные из электронной таблицы Excel или таблицы Word можно вставлять в документы InDesign или InCopy. Формат текста, вставляемого из других приложений, задается установками раздела «Обработка буфера». Если выбран параметр «Только текст», то данные отображаются в виде неотформатированного текста с табуляцией, который затем можно преобразовать в таблицу. Если выбран параметр «Вся информация», то вставляемый текст будет отображаться в отформатированной таблице.
Если текст вставляется в существующую таблицу из другого приложения, создайте в ней достаточное для его размещения число строк и столбцов, в установках раздела «Обработка буфера» выберите «Только текст» и убедитесь, что выделена хотя бы одна ячейка (за исключением случаев, когда в ячейку необходимо вставить всю таблицу).
Если нужен больший контроль над форматированием импортируемой таблицы или необходимо сохранить форматирование электронной таблицы, лучше произвести ее импорт командой «Поместить». Если необходимо создать связь с форматированием электронной таблицы, выберите параметр «Создавать связи при размещении текстовых и табличных файлов» в настройках «Обработка файлов».
Можно также скопировать и вставить текст, разделенный символами табуляции, в диапазон ячеек таблицы. Этим способом удобно заменять содержимое при необходимости сохранить форматирование. Предположим, вам нужно обновить содержимое отформатированной таблицы в ежемесячном журнале. Одним из вариантов является связь с электронной таблицей Excel. Однако, если содержимое происходит из другого источника, можно скопировать текст с табуляцией в буфер обмена, выделить диапазон ячеек в отформатированной таблице InDesign и вставить в него содержимое.
Задание 2. Ячейка таблицы может содержать текст, привязанные объекты, XML-теги и другие таблицы. При вставке текста высота строки таблицы будет соответствующим образом увеличена, за исключением случаев, когда для строки задана фиксированная высота. В таблицы нельзя вставлять сноски.
С помощью инструмента «Текст» [image: ] выполните одно из следующих действий:
Поместите точку ввода в ячейку и введите текст. Чтобы создать новый абзац в той же ячейке, нажмите клавишу «Ввод» или «Return». Перемещение по ячейкам производится по нажатию клавиши «Tab» (при нажатии клавиши «Tab» в последней ячейке добавляется новая строка). Перемещение по ячейкам в обратном порядке производится по нажатию комбинации клавиш
«Shift» и «Tab».
Скопируйте   текст,    установите    в    ячейке    точку    ввода,    затем    выберите    команду
«Редактирование» > «Вставить».
Поместите точку ввода в то место, куда нужно добавить текст, выберите команду «Файл» >
«Поместить», а затем дважды щелкните на текстовый файл.
Задание 3. Поместите точку ввода в ячейку таблицы, в которую нужно добавить изображение. Выберите «Файл» > «Поместить», а затем выберите один или два графических файла.
Выберите и перетащите один или несколько графических объектов из категории «Графика» на палитре «Библиотеки CC».

Изображения появятся в инструменте PlaceGun.
Чтобы поместить изображения, щелкайте внутри ячеек таблицы.
При добавлении графического объекта в меньшую по размеру ячейку высота ячейки будет увеличена, а ширина ячейки останется прежней, то есть часть объекта может оказаться за правой границей ячейки. Если строка, в которую помещается графический объект, имеет фиксированную высоту, а высота объекта превышает высоту строки, это приведет к вытеснению содержимого ячейки.
Изображения также можно помещать в ячейки таблицы, используя описанные ниже способы.
Выберите «Объект» > «Привязанный объект» > «Вставить», затем укажите настройки вставки. Позднее в привязанный объект можно добавить графику.
Скопируйте графический объект или фрейм, расположите точку ввода в нужном месте, затем выберите команду «Редактирование» > «Вставить».
Задание 4.  Если требуется создать несколько схожих строк и  столбцов или дублировать столбцы и строки, можно использовать различные методы.
Можно выполнить следующие стандартные операции со строками и столбцами таблицы:
Перетаскивание строк и столбцов таблицы из одного расположения в другое в пределах одной таблицы.
Создание дубликатов строк и столбцов.
Вставка строк и столбцов перед или после других строк/столбцов. Копирование содержимого строки в столбец или содержимого столбца в строку. Перетаскивание и создание дубликатов строк/столбцов
Можно перетаскивать строки и столбцы таблицы из одного расположения в другое в пределах одной таблицы. Для перетаскивания и создания дубликатов строк/столбцов выполните следующие действия.
Выберите строку или столбец, которые необходимо перетащить в другую строку или столбец. Убедитесь, что выбран весь столбец или строка. Невозможно перетащить частично выделенную строку или столбец.
Наведите указатель мыши на выбранные строки. Отобразится уникальный курсор, означающий, что выделенную область можно переместить.
Строку элемента можно перетащить. Можно менять местами столбцы и строки. Перетаскиваемая строка вставляется только в виде строки, а перетаскиваемый столбец – только в виде столбца. Ниже показано перетаскивание строк и столбцов.
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В данном примере при перемещении строки из одного расположения в другое сохраняется прежнее количество строк: только 3.
Чтобы создать дубликат строки или столбца, выберите строку или столбец, а затем нажмите или удерживайте клавишу «Alt» (Win) или «Opt» (Mac). Можно перетащить несколько последовательно выбранных строк или столбцов.

Перетащите выбранную строку или столбец в требуемое расположение. Общее число строк или столбцов увеличивается по мере создания дубликатов выбранного объекта.
Можно также скопировать содержимое из строк верхнего и нижнего колонтитулов в строки основной области (нажав клавишу Alt/Opt). Подобным образом строки основной части можно дублировать и преобразовать в строки верхнего и нижнего колонтитулов.
Если клавиша Alt/Opt не используется для дублирования строк, верхние колонтитулы можно перетаскивать только внутри раздела верхних колонтитулов (доступно только при наличии нескольких верхних колонтитулов). Если клавиша Alt/Opt не используется для дублирования строк, невозможно перетащить строки основной области в раздел верхних колонтитулов.
Копирование строк/столбцов и вставка до/после
Вы можете копировать и вставлять строки до или после выбранной строки. С помощью команды «Вставить до/после» можно также скопировать строки/столбцы таблицы и вставить их в другую таблицу.
Выберите строку/столбец. Выберите столбец или строку.
Выберите команду «Таблица» > «Вставить до»/«Вставить после».
Задание 5. Для вставки строк и столбцов предусмотрено несколько различных способов.
Вставка строки
Поместите точку ввода в строку, рядом с которой нужно вставить новую строку. Выберите команду «Таблица» > «Вставить» > «Строка».
Задайте нужное количество строк.
Укажите место вставки новых строк по отношению к текущей (до нее или после), затем нажмите кнопку «ОК».
Новые ячейки будут отформатированы так же, как текст в строке, где находилась точка ввода.
Вставка столбца
Поместите точку ввода в столбец, рядом с которым необходимо вставить новый столбец. Выберите команду «Таблица» > «Вставить» > «Столбец».
Задайте необходимое количество столбцов.
Укажите место вставки новых столбцов по отношению к текущему (до него или после), затем нажмите кнопку «ОК».
Новые ячейки будут отформатированы так же, как и текст в столбце, где находилась точка ввода.
Вставка нескольких строк и столбцов
Установив точку ввода в ячейку, выберите меню «Таблица» > «Параметры таблицы» >
«Настройка таблицы».
Задайте другое количество строк и столбцов, а затем нажмите кнопку «ОК».
Новые строки будут добавлены в конец, а новые столбцы — с правого края таблицы.
Вставка строки или столбца путем перетаскивания
Столбцы можно добавить перетаскиванием. Для этого нужно перетащить столбец на расстояние, которое в полтора раза превышает его ширину. Ширина нового столбца будет равна ширине перетаскиваемого столбца. Если перетаскиванием вставляется один столбец, то его ширина после вставки может отличаться от исходной. Поведение строк аналогично, за исключением случая, когда высота перетаскиваемой строки ограничена значением «Не менее». В этом случае при создании одной строки перетаскиванием InDesign при необходимости увеличит высоту новой строки для размещения в ней текста.

[image: ]Поместите инструмент «Текст» [image: ]  на границе столбца или строки таким образом, чтобы появилась двунаправленная стрелка (    или [image: ]).
Перетащите указатель вниз (для создания новой строки) или вправо (для создания нового столбца), удерживая кнопку мыши и клавишу «Alt» (Windows). Если нажать клавишу «Alt» («Option») перед нажатием кнопки мыши, то появится инструмент «Рука», поэтому кнопку мыши необходимо нажать первой.
Задание 6. Чтобы удалить строку, столбец или таблицу, поместите точку ввода внутрь таблицы или выделите в ней текст, затем выберите команду «Таблица» > «Удалить» > «Строка»,
«Столбец» или «Таблица».
Чтобы удалить строки и столбцы через диалоговое окно «Параметры таблицы», выберите команду «Таблица» > «Параметры таблицы» > «Настройка таблицы». Задайте другое количество строк и столбцов, а затем нажмите кнопку «ОК». Строки удаляются с конца таблицы, а столбцы — с правого края.
[image: ]Чтобы удалить строку или столбец при помощи мыши, установите курсор мыши на нижней или правой границе таблицы, чтобы появился значок двунаправленной стрелки (      или [image: ]), нажмите кнопку мыши, а затем, удерживая нажатой клавишу «Alt» (Windows), перетащите вверх (для удаления строк) или влево (для удаления столбцов).
Чтобы удалить содержимое ячейки, не удаляя саму ячейку, выделите ее или выделите в ней текст с помощью инструмента «Текст». Нажмите клавишу «Backspace» или «Delete» либо выберите команду «Редактирование» > «Очистить».
Задание 7. При создании таблицы ее ширина определяется шириной абзаца или ячейки родительской таблицы. Однако размер текстового фрейма или таблицы можно увеличить или уменьшить, что сделает таблицу более узкой или более широкой, чем фрейм. В этом случае, возможно, потребуется выровнять таблицу в пределах фрейма.
Поместите точку ввода справа или слева от таблицы. Убедитесь, что точка ввода находится на абзаце таблицы, а не внутри самой таблицы. Точка ввода примет ту же высоту, что и таблица во фрейме.
Нажмите кнопку выравнивания (например, «Выключка по центру») на палитре «Абзац» или на панели «Управление».
Задание 8. Параметры удержания позволяют указать, сколько строк должно остаться без переноса, либо задать место переноса (например, в верхней части столбца или фрейма).
Если фрейм не вмещает все строки создаваемой таблицы, она называется вытесненной. Если фреймы связаны в цепочку, то таблица будет продолжена в следующем фрейме. Содержимое таблицы переносится в связанный фрейм построчно; разделить одну и ту же строку по нескольким фреймам нельзя. Строки верхнего и нижнего колонтитула повторяются в каждом фрейме.
Поместите точку ввода на нужную строку или выделите диапазон ячеек, строки которых должны быть неразрывными.
Выберите команду «Таблица» > «Параметры ячейки» > «Строки и столбцы».
Чтобы выделенные строки оставались неразрывными, выберите «Удержать следующую строку».
Чтобы перенести строку в указанной точке, выберите соответствующую команду (например,
«В следующем фрейме») в меню «Начать строку» и нажмите «ОК».

Задание 9. Ячейки таблицы можно объединить или разбить (разъединить).
Объединить ячейки
Если в одной строке или столбце есть по крайней мере две ячейки, их можно объединить в одну. Например, можно объединить все ячейки, расположенные в первой строке таблицы, и поместить в получившуюся ячейку заголовок таблицы.
Выберите инструмент «Текст» [image: ] и выделите ячейки, которые необходимо объединить. Выберите команду «Таблица» > «Объединить ячейки».
Разъединить ячейки
Поместите точку   ввода   в   объединенную   ячейку   и   выберите   команду   «Таблица»   >
«Разъединить ячейки».
Разбиение ячеек
Ячейки можно разбивать по горизонтали или по вертикали, что очень удобно при создании таблиц форм. Можно выбрать несколько ячеек и разбить их по вертикали или по горизонтали.
Поместите точку ввода в ячейку, которую нужно разбить, либо выделите строку, столбец или блок ячеек.
Выберите команду «Таблица» > «Разделить ячейку по вертикали» или «Разделить ячейку по горизонтали».


ПРАКТИЧЕСКАЯ РАБОТА 6

Цель: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы
1. Задание формата бумаги и ориентации страницы.
2. Определение заказного формата страницы.
3. Выбор слоев для печати.
4. Печать как растрового изображения.
Задание 1. Выделите фрейм с помощью инструмента «Выделение», либо щелкните внутри фрейма или выделите текст с помощью инструмента «Текст».
Выберите меню «Объект» – «Параметры текстового фрейма».
Задайте для текстового фрейма количество колонок, ширину каждой и интервал между колонками (средник).
Чтобы при изменении размера фрейма сохранить ширину колонок, используйте параметр
«Одинаковая ширина колонок». Если этот параметр включен, при изменении размера фрейма может измениться количество колонок, но не заданная ширина.

[image: ]
Выберите «Балансировать столбцы», чтобы выровнять текст внизу текстового фрейма, состоящего из нескольких столбцов.
[image: ]
[image: ]Задание 2. Изучите способы верстки иллюстраций.
Задание 3. Создайте макет бизнес-журнала.
Первое, что нужно определить для создания правильного макета – это количество страниц и формат. Так же нужно учесть количество колонок в тексте и свободные поля.

[image: ]



Перейдите в "А-мастер" и настраивайте нумерацию страниц и верхние колонтитулы. Так же нужно продумать стиль оформления.


[image: ]

Теперь разворот нужно наполнить содержимым. Этот этап является самым сложным, поскольку нужно одновременно учитывать сразу несколько вещей: грамотно размещать элементы, выделять главное, помнить о принципах тождества, контраста и нюанса. В итоге должно получиться примерно так, как показано ниже.

[image: ]

Задание 4. Создайте шаблон обложки бизнес-журнала.
Задание 5. Выберите меню «Файл» > «Печать». В области «Настройка» диалогового окна
«Печать» выберите параметр в меню «Формат бумаги».
Необходимо убедиться, что формат бумаги достаточен, чтобы вместить в себя документ, область выпуска за обрез, служебную область (если она включена) и некоторые типографские метки. Несмотря на то, что указанный формат бумаги меньше необходимого для сохранения пленок устройства вывода изображения и бумаги, он будет приспособлен под текущий документ и необходимую для печати информацию.
Нажмите кнопку «Ориентация», чтобы повернуть документ на печатном материале.
В большинстве случаев ориентация страницы, заданная в окне «Параметры документа» («Файл» > «Параметры документа»), и ориентация при выводе, заданная в области «Настройка» диалогового окна «Печать», должна быть одинаковой (книжной или альбомной) как для обычной, так и для поперечной печати. При печати разворотов можно выбрать разный формат бумаги и разную ориентацию (например, альбомную), чтобы поместить страницы разворота на одном листе. Для правильной печати повернутого разворота можно менять его ориентацию.
[image: ]

Задание 6. Выберите меню «Файл» > «Печать».
При печати PostScript-файла выберите PostScript для принтера в области «Основные» диалогового окна «Печать». Затем выберите PPD, поддерживающий заказной формат бумаги.
В области «Настройка» диалогового окна «Печать» выберите «Заказной» в меню «Формат бумаги».
Примечание. Если параметр «Заказной» недоступен, PPD, выбранный при настройке принтера, не поддерживает заказной формат бумаги.
Чтобы указать ширину и высоту, воспользуйтесь одним из следующих способов.
Чтобы позволить InDesign определить наименьший формат бумаги, необходимый для документа вместе с областью выпуска за обрез или служебной областью и некоторыми типографскими метками, выберите параметр «Авто» для «Ширина» и «Высота». «Авто» – стандартный параметр, полезный при наличии различных размеров страниц в книге и при печати на непрерывном материале, таком как пленочная катушка или светочувствительная бумага.
Чтобы задать формат больше стандартного, введите новые размеры в текстовое поле
«Ширина» и «Высота». Значения должны быть больше исходных; уменьшение стандартных значений может привести к обрезке документа.
Для изменения положения страницы на пленке введите значение для параметра «Смещение».
Значение параметра «Смещение» определяет значение интервала по левой стороне области изображения. Например, при вводе значения в 30 точек в параметр «Смещение» происходит сдвиг страницы на 30 точек вправо.
Чтобы повернуть содержимое и пленки, и страницы, выберите «Поперечная» и нажмите кнопку «ОК».
Можно сэкономить значительное количество пленки и бумаги, используя одновременно
«Повернуть на 90°» и «Смещение». Сравните следующие примеры изображений, напечатанных
InDesign с использованием параметра «Повернуть на 90°» и без него.


[image: ]

Чтобы показать различие между отдельными страницами при печати на непрерывном медианосителе, введите значение зазора.
Задание 7. Для просмотра и изменения установок «Показать слой» и «Печатать слой» выделите слой на палитре «Слои», а затем выберите в меню палитры команду «Параметры слоя». Задайте параметры слоя и нажмите кнопку «ОК».
Выполните одно из следующих действий:
· выберите меню «Файл» > «Печать» и щелкните в левой части диалогового окна «Печать» раздел «Основные»;
· выберите меню «Файл» > «Экспорт», затем тип «Adobe PDF» и нажмите кнопку
«Сохранить». В   левой   части   диалогового   окна   «Экспорт   Adobe   PDF»   выберите   раздел
«Основные».
В меню «Печатать слои» или «Экспортировать слои» выберите слои, которые необходимо напечатать (включить в PDF);
· все слои;
· на печать или в файл выводятся все слои документа, даже если они скрыты или определены как непечатаемые;
· видимые слои
На печать или в файл выводятся все видимые слои, даже если они в диалоговом окне
«Параметры слоя» определены как непечатаемые.
Видимые и печатаемые слои
На печать или в файл выводятся только те слои, которые определены и как видимые, и как печатаемые.
Задание 8. При использовании принтера без поддержки PostScript может быть задано растрирование всех графических объектов в процессе печати. Эта возможность используется при печати документов, содержащих сложные объекты (например, объекты с затенением или градиентами), поскольку она снижает вероятность возникновения ошибок.
Выберите меню «Файл» > «Печать».
В левой части диалогового окна «Печать» выберите раздел «Дополнительные». Выберите параметр «Печатать как растровый».
Этот параметр доступен только в случае, если принтер определен, как принтер не поддерживающий PostScript.
Задайте разрешение для печати битовых изображений.
Выходное разрешение может быть ограничено разрешением драйвера принтера. Чтобы получить на выходе максимальное качество, задайте для принтера без поддержки PostScript разрешение, большее или равное выходному, которое в InDesign указывается в диалоговом окне
«Печать».


ПРАКТИЧЕСКАЯ РАБОТА 7

Цель: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы

1. Векторные контуры.
2. Рисование контуров и фигур.
3. Кривая Безье с разными типами узловых точек.
4. Векторные цветные фигуры.
5. Рисование пером.
6. Выделение и преобразование контуров.
[image: ]Задание 1. Подготовьте макет рекламной статьи по продаже недвижимости.
Задание 2. Подготовьте макет статьи:
[image: ]
Задание 3. Подготовьте макет статьи.

[image: ]

Задание 4. Подготовьте макет статьи.

[image: ]

ПРАКТИЧЕСКАЯ РАБОТА 8

Цель: познакомиться с возможностями приложения Adobe InDesign.
Теоретические вопросы
1. Слои.
2. Работа со слоями.
3. Способы оформления рекламы.
Задание 1. Слои можно представить себе как прозрачные листы пленки, сложенные в стопку. Если на слое отсутствуют объекты, через этот слой можно видеть любые другие объекты на слоях, расположенных ниже.
[image: ]

Расположите указатель на палитре Layers (Слои), щелкните на слое Number и, не отпуская левой кнопки мыши, перетащите этот слой между слоями Floor и Graphics. Когда вы увидите, что появляющаяся черная линия отображается в том месте, куда должен быть перемещен слой, отпустите левую кнопку мыши. Обратите внимание, как отображаются объекты с другим порядком расположения в документе, так как сейчас некоторые объекты помещены над другими объектами.

[image: ]


Щелкните на пустом квадрате, расположенном слева от имени слоя Number. Этот квадрат позволяет заблокировать слой, чтобы он был недоступен для редактирования. Когда слой заблокирован, в палитре отображается значок перечеркнутого карандаша ([image: ]) в соответствующем квадрате.
[image: ]

Используя инструмент выделения ([image: ]), щелкните на слове " Floor " в окне документа. Обратите внимание, что в палитре Layers (Слои) выделен слой Graphics и справа от имени этого слоя отображается точка. Это указывает на то, что выбранный объект принадлежит данному слою.

Объекты можно перемещать с одного слоя на другой, перетаскивая данную точку между слоями в палитре.
В палитре Layers (Слои) перетащите точку со слоя Graphics на слой Floor. Теперь слово "Floor" принадлежит слою Floor и отображается в документе согласно соответствующему порядку наложения.
[image: ]

Сейчас, когда выполнено редактирование слоев, можно щелкнуть на значке перечеркнутого карандаша для слоя Number, чтобы разблокировать этот слой.
Задание 2. Подготовьте рекламную листовку для магазина примерно такого вида.

[image: ]

Задание 3. Подготовьте рекламную листовку для магазина примерно такого вида.

[image: ]
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Цель: познакомиться с основами построения и использования шрифтов.
Теоретические вопросы
1. История и эволюция шрифта.
2. Современные шрифты.
3. Классификация современных типографских шрифтов.
4. Основные требования к шрифту.
5. Взаимосвязь рисунка букв с содержанием текста.
6. Удобочитаемость.
7. Шрифтовая композиция в различных жанрах печатной графики.
8. Цвет в шрифтовой композиции. Художественное единство шрифтов.
Задание 1. Опишите основные атрибуты стиля текста.
Задание 2. Опишите основные элементы литер, составляющих шрифт.

[image: ]


Задание 3. Приведите понятия.


	Серифы (засечки)
	

	Пуансон (очко)
	

	Базовая линия
	

	Гарнитура шрифта
	

	Начертание
	

	Топометрические единицы
	

	Пункт (point или pt)
	

	Кегль
	

	Выключка (Выравнивание текста)
	



	Междусловный пробел
	

	Емкость и насыщенность шрифта (Weight)
	

	Контрастность шрифта
	

	Leading (интерлиньяж)
	



Задание 3. Определите емкости и насыщенности шрифта.

[image: ]

Задание 4. Изучите советы и рекомендации при работе со шрифтами.
· Шрифты – это то, на чем нужно экономить в последнюю очередь. Основная часть сбоев при выводе на ФНА вызывается именно ими. Используйте только проверенные лицензионные шрифты. Вместе с работой передавайте в сервисное бюро все используемые в публикации шрифты во избежание проблем, вызванных использованием разных версий.
· Используйте шрифты PostScript (Adobe Type 1) – они должны иметь два файла: .pfb – принтерную версию и .pfm – экранную версию (вместо .pfm могут присутствовать два других файла – .afm и .inf). Дата и время создания всех файлов одного набора должны совпадать, поскольку их генерация происходит одновременно.
· В системе должна присутствовать только одна версия конкретного шрифта – или Type 1,
или TrueType, если это не так, удалите один из них.
· Никогда не спешите при выборе шрифтов для публикации, старайтесь серьезно относиться даже к таким мелочам как трекинг, интерлиньяж, отступы и прочее.

· Помните, что каждый дополнительно устанавливаемый на компьютер шрифт отнимает у него кусочек оперативной памяти. Будьте разумны, следите за количеством шрифтов, и удаляйте лишние (не используемые в работе) шрифты.
· Осторожно относитесь к использованию особо вычурных (декоративных) шрифтов, неумелое применение которых может оттолкнуть читателей от ваших материалов. Выбор красивого, но плохо читаемого шрифта является частой ошибкой начинающих.
· При выборе шрифта для публикации следует исходить из его легкости для чтения и адекватности, т.е. соответствия стилю публикации. Для строгих документов имеет смысл применять только классические шрифты и не больше двух на страницу. В остальных случаях также важно соблюдать меру; считается, что максимальное число шрифтов на одной странице – три. Слишком много шрифтов свидетельствуют об отсутствии профессионализма у автора публикации (как и злоупотребление декоративными шрифтами).
· Общим принципом для работы является применение гарнитур с засечками для основного текста и рубленых – для заголовков и других элементов. Но нет правил без исключений. В одном документе можно ограничиться только рублеными гарнитурами, в другом – только с засечками. Надо только учитывать, что текст, набранный рубленым шрифтом, труднее читать (особенно это касается больших объемов текста).
· Нецелесообразно использовать в наборе стихотворных произведений шрифты, предназначенные для набора газет или словарей, а в газетах или словарях – шрифты для набора монографий по искусству или старославянских изданий.
· Для заголовков и подзаголовков применяйте более жирное начертание. Избегайте одинаковых гарнитур для заголовков и основного текста. С другой стороны, для заголовков и подзаголовков лучше использовать схожие гарнитуры; это же касается тех случаев, когда в основном тексте существует несколько гарнитур. Если заголовок занимает более трех строк, гарнитура должна быть равна по насыщенности основному тексту. Если гарнитуры заголовка и текста совпадают, отделите заголовок от текста. Используя полужирное начертание шрифта для первых слов заголовка, вы как бы даете шапку, а набор курсивом поможет отделить заголовок от основного текста, не отвлекая внимания. Если заголовок занимает менее трех строк, эффектно смотрится гарнитура более солидного вида, чем у основного текста.
· Разрешение вашего принтера тоже влияет на выбор шрифтов. На 600-точечном "лазернике" любой мелкий шрифт будет выглядеть вполне прилично. А вот на 300-точечном "струйнике" – вряд ли. Помните, что на экране монитора вообще любой шрифт идет с разрешением 72 dpi.
· Обратите внимание на длину строк. Не зря же газеты и журналы сверстаны обычно в две или более колонок. Для удобочитаемости обычного текста, оформленного кеглем 9–10, оптимальная длина строки примерно 85 мм (допустимо от 63 до 125 мм). Ухудшение читаемости в этом случае можно отчасти компенсировать увеличением расстояния между строками (интерлиньяжем). Выбрали для основного текста кегль 10 – поставьте интерлиньяж на 1–2 пункта больше (то есть 11–12 пунктов), если длина строки у вас в рекомендованных выше пределах. И добавьте еще 1–2 пункта, если она приближается к 170–180 мм.
· Для удобочитаемости текста важную роль играют поля. Знаете ли вы, что в классическом книгопечатанье поля занимают около 50 % площади страницы? Назначаются поля по определенным системам разметки, которые тоже разными бывают. Для листа формата А4 в классической пропорции верхнее поле получается 25 мм, боковые по 35 и нижнее – 50 мм. Если страница А4 воспринимается как половина разворота, скажем книги, то верхнее поле будет 33 мм, нижнее 66 мм, внутренние боковые – по 23 мм и

наружные боковые поля увеличиваются до 47 мм.
· Назначайте фону и тексту контрастные цвета. Речь идет о контрастности именно цвета, а не просто о различной яркости. Например, черные буквы на красном фоне читаются с большим трудом, так что такого сочетания следует, по возможности, избегать.
· Проверяйте контрастность текста и фона на монохромном изображении. Хотя этот прием срабатывает не всегда, но в большинстве случаев, когда два цвета выглядят контрастно в монохромном изображении, они будут выглядеть контрастно и при цветной печати.
· Избегайте раздражающего сочетания цветовых тонов для печати объемного текста. Например, сочетание желтого с красным очень действенно для полиграфической продукции с ярлыком "New!", но такое цветовое решение в большинстве других случаев неуместно.
· Помните о треппинге. При печати цветными буквами по цветному фону может возникнуть искажение символов за счет треппинга, при котором размеры символов могут несколько меняться. Общее правило состоит в том, что при треппинге гарнитуры без засечек лучше сохраняют форму, чем гарнитуры с засечками (т треппинге речь пойдет в главе, посвященной печати).
· Избегайте слишком светлых и плохо различимых оттенков. Точные рекомендации по поводу воспроизведения оттенков при печати сможет дать только технолог типографии. Оттенки светлее 20 % могут быть неудобны для воспроизведения при печати, вне зависимости от того, хорошо или плохо такой оттенок смотрится на фотоформе, выведенной на фотонаборной машине с высоким разрешением. Плохо воспроизводятся тонкие линии, для которых выбран светлый оттенок цвета. Может получиться даже так, что такой цвет будет выглядеть просто как грязь на бумаге.
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Цель: познакомиться с основами построения и использования шрифтов.
Теоретические вопросы
1. История и эволюция шрифта.
2. Современные шрифты.
3. Классификация современных типографских шрифтов.
4. Основные требования к шрифту.
5. Взаимосвязь рисунка букв с содержанием текста.
6. Удобочитаемость.
7. Шрифтовая композиция в различных жанрах печатной графики.
8. Цвет в шрифтовой композиции. Художественное единство шрифтов.
Задание 1. Создайте шаблон календаря, например, как показано ниже.

[image: ]

[image: ]

…

[image: ]


Цель: познакомиться с основами построения и использования шрифтов.
Теоретические вопросы
1. История и эволюция шрифта.
2. Современные шрифты.
3. Классификация современных типографских шрифтов.
4. Основные требования к шрифту.
5. Взаимосвязь рисунка букв с содержанием текста.
6. Удобочитаемость.
7. Шрифтовая композиция в различных жанрах печатной графики.
8. Цвет в шрифтовой композиции. Художественное единство шрифтов.
Задание 1. Опишите группы шрифтов.


	Группа 1. Шрифты с засечками (serif)
	
[image: ]

	Группа 2. Шрифты без засечек (sans serif –
гротески, рубленые или брусковые)
	[image: ]



	Группа 3. Шрифты декоративные или свободного стиля (Decorative)
	[image: ]



Задание 2. Подготовьте макет.

[image: ]

Задание 3. Подготовьте макет.

[image: ]
Задание 4. Подготовьте макет.

[image: ]




Цель: познакомиться с основами выполнения орнамента.
Теоретические вопросы
1. Виды орнамента.
2. Основы выполнения растительного орнамента.
3. Основы выполнения геометрического орнамента.
4. Орнамент линейный (фриз, бордюр), сетчатый, розетта.
5. Стилизация природных форм в орнаменте.
[image: ]Задание 1. Подготовьте макет растительного орнамента, например, как приведено ниже.
Задание 2. Подготовьте макет геометрического орнамента.

[image: ]

Задание 3. Подготовьте макет комбинированного орнамента.

[image: ]


Цель: познакомиться с основами выполнения орнамента.
Теоретические вопросы
1. Виды орнамента.
2. Основы выполнения растительного орнамента.
3. Основы выполнения геометрического орнамента.
4. Орнамент линейный (фриз, бордюр), сетчатый, розетта.
5. Стилизация природных форм в орнаменте.
Задание 1. Подготовьте макет линейного орнамента.

[image: ]

[image: ]
Задание 2. Подготовьте макет сетчатого орнамента.

[image: ]

[image: ]

Задание 3. Подготовьте макет розетты.

[image: ]

[image: ]




Цель: познакомиться с основами проектирования архитектонических композиций.
Теоретические вопросы
1. Правила, принципы и методы создания архитектонических композиций.

2. Использование	ассоциативных	мотивов	при	проектировании	архитектонических композиций.
[image: ]Задание 1. Подготовить архитектоническую композицию.
Задание 2. Подготовить архитектоническую композицию.
[image: ]


Цели: познакомиться с основами проектирования объемно-пространственных композиций.
Теоретические вопросы
1. Законы композиции объёмно-пространственных форм.
2. Приёмы пластического и декоративного решения объёмных композиций.
3. Различные приёмы техники архитектоники.
4. Пространственные свойства цвета, комбинаторные методы проектирования
Задание 1. Подготовить композицию в цвете.

[image: ]

[image: ]Задание 2. Подготовить объемно-пространственную композицию в цвете.

[image: ]






Цель: познакомиться с основами выполнения модульной композиции.
Теоретические вопросы
1. Понятие модуля.
2. Принципы проектирования пластики модуля и цветового решения.
3. Правила проектирование модульной сетки, масштаб и пропорции в модульной композиции.
Задание 1. Выполнить модульную композицию на заданную тему:
· модульная композиция из правильных геометрических фигур (разных по форме и размеру);
· модульная	композиция	на	основе	сочетания	разных	метрических	порядков	(с использованием графических средств: точка, линия, пятно);
· модульная композиция на основе сочетания разных ритмических рядов (с использованием графических средств: точка, линия, пятно);
· композиция на модульной основе и выполнении условий (равновесие, единство и соподчинение);
· модульная композиция из кривых линий (волнистых, ломаных, радиальных).
Цель: познакомиться с основами выполнения модульной композиции.
Теоретические вопросы

1. Понятие модуля.
2. Принципы проектирования пластики модуля и цветового решения.
3. Правила проектирование модульной сетки, масштаб и пропорции в модульной композиции.
Задание 1. Разработать дизайн-проект наружной рекламы и световых вывесок различного типа.
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Цель: познакомиться с форматами электронных изданий.
Теоретические вопросы
1. Виды электронных изданий.
2. Формат электронных изданий. Их общие и различные настройки.
Задание 1. Опишите форматы электронных изданий.


	PDF (Portable Document Format)
	

	HTML (Hyper Text Markup Language)
	



Задание 2. Приведите примеры и характеристики программных средств, используемых для разработки электронных изданий.
Задание 3. Перечислите составные характеристики электронных изданий.


	Тексты
	

	Иллюстративный материал
	

	Звуковое сопровождение
	

	Анимация и видео
	



Задание 4. Приведите классификацию электронных изданий.


	Признак
	Классификация

	Периодичность издания
	

	Круг потребителей продукции
	

	Вид издания
	

	Способ распространения
	

	Формат издания
	



Задание 5. Каковы современное состояние и перспективы развития электронных изданий?


Цель: познакомиться с основами оформления гиперссылок на различные источники.
Теоретические вопросы
1. Гиперссылки.
2. Виды гиперссылок.
3. Различные методы добавления источника.
Задание 1. Создание гиперссылок.
Можно создавать гиперссылки, указывающие на страницы, URL-адреса, текстовые привязки, адреса электронной почты и файлы. При создании гиперссылки на страницу или текстовую привязку в другом документе убедитесь, что экспортируемые файлы находятся в той же папке.
Создание гиперссылки на веб-страницу (URL-адрес)
Для создания гиперссылок на URL-адреса можно использовать несколько методов. При указании URL-адреса можно использовать любой допустимый протокол доступа к ресурсам Интернет: http://, file://, ftp:// или mailto://.
Для создания ссылок на веб-страницы можно также использовать функцию «Кнопки». Щелкните правой кнопкой мыши выбранный текст, фрейм или графику, а затем выберите
«Гиперссылки» > «Новая гиперссылка». Появится диалоговое окно «Новая гиперссылка».

[image: ]

Укажите нужный URL-адрес:
· в	текстовом	поле	«URL-адрес»	введите	или	вставьте	URL-адрес	(например,
http://www.adobe.com). Убедитесь, что в раскрывающемся меню «Связать с» выбран параметр
«URL»;
· в	раскрывающемся	меню	«URL-адрес»	выберите	ранее	добавленный	URL-адрес. Оформление гиперссылки будет то же, что и для предыдущего URL-адреса.
Создание гиперссылки к файлу

Щелчок по гиперссылке в экспортированном файле PDF или SWF приводит к запуску приложения, предназначенного для работы с этим файлом. Например, файлы *.doc открываются в программе Microsoft Word.
Обеспечивайте доступ к указываемому файлу для всех пользователей, открывающих экспортированный файл PDF или SWF. Например, при отправке экспортированного файла PDF коллеге указывайте имя файла, размещенного на общедоступном сервере, а не на своем жестком диске.
Выберите текст, фрейм или графику для использования в качестве источника гиперссылки. Выберите «Новая гиперссылка» в меню палитры «Гиперссылки» или нажмите кнопку
«Создать новую гиперссылку» в нижней части палитры «Гиперссылки».
В диалоговом окне «Новая гиперссылка» выберите «Файл» в меню «Связать с».
Для параметра «Путь» введите путь или щелкните кнопку папки, выберите файл и дважды щелкните его имя.
Выберите пункт «Общая привязка гиперссылки», если требуется хранение файла в палитре
«Гиперссылка» для удобства повторного использования.
Задайте оформление источника гиперссылки и нажмите кнопку «OK».
Создание гиперссылки к сообщению электронной почты
Выберите текст, фрейм или графику для использования в качестве источника гиперссылки. Выберите «Новая гиперссылка» в меню палитры «Гиперссылки» или нажмите кнопку
«Создать новую гиперссылку» в нижней части палитры «Гиперссылки».
В диалоговом окне «Новая гиперссылка» выберите «Email» в меню «Связать с».
В строке «Адрес» введите адрес электронной почты, например username@company.com.
В поле «Тема» введите текст, отображаемый в строке темы сообщения электронной почты.
Выберите пункт «Общая привязка гиперссылки», если требуется хранение сообщений электронной почты в палитре «Гиперссылка» для удобства повторного использования.
Задайте оформление источника гиперссылки и нажмите кнопку «OK».
Создание гиперссылки на страницу
Можно создать гиперссылку на страницу, без предварительного указания привязки. Однако создание привязки к странице позволяет указать номер страницы и просмотреть настройки.
Выберите текст, фрейм или графику для использования в качестве источника гиперссылки. Выберите «Новая гиперссылка» в меню палитры «Гиперссылки» или нажмите кнопку
«Создать новую гиперссылку» в нижней части палитры «Гиперссылки».
В диалоговом окне «Новая гиперссылка» выберите пункт «Страница» в меню «Связать с».
В меню «Документ» выберите документ, содержащий привязку для перехода. Во всплывающем меню отобразится список всех сохраненных открытых документов. Если нужный документ не открыт, выберите «Обзор» во всплывающем меню, найдите файл, затем нажмите кнопку «Открыть».
В меню «Страница» укажите номер страницы для перехода.
В меню «Масштаб», чтобы выбрать состояние просмотра страницы, на которую указывает гиперссылка, выполните одно из следующих действий:
· выберите «Фиксированный» для отображения уровня масштабирования и положения страницы на момент создания ссылки;
· выберите «Текущий вид» для отображения видимой части текущей страницы в качестве привязки;

· выберите «По размеру окна» для отображения текущей страницы в окне привязки;
· выберите По ширине или «По высоте» для отображения ширины или высоты текущей страницы в окне привязки;
· выберите «По содержимому», чтобы текст и графика страницы были развернуты на всю ширину окна (это обычно означает, что поля не отображаются);
· выберите «Текущий масштаб» для отображения окна привязки с масштабом, который использовался при переходе по гиперссылке.
Укажите параметры оформления и нажмите «OK».
Создание привязки
Создание привязки требуется только в том случае, если вы создаете гиперссылку или перекрестную ссылку к привязке к тексту. Привязка к тексту может указывать на выделенный текст или на позицию точки ввода. Затем создается гиперссылка или перекрестная ссылка, указывающая на эту привязку. Можно также создать привязку к гиперссылкам для страниц и URL-адресов, но указывать привязку для этих ссылок необязательно.
Привязки не отображаются в палитре «Гиперссылки»; они отображаются в диалоговом окне, открывающемся при создании или редактировании гиперссылок.
При создании привязки к тексту с помощью инструмента «Текст» поместите в документ точку ввода или выберите фрагмент текста, который должен служить в качестве привязки.
Для текста на странице-шаблоне задать привязку нельзя.
Выберите в меню палитры «Гиперссылки» пункт «Новая привязка».
Выберите «Привязка к тексту» в меню «Тип». Укажите имя привязки к тексту и нажмите
«OK».
Выполните любое из следующих действий и нажмите «ОК»:
· выберите «Привязка к тексту» в меню «Тип». Укажите имя для привязки к тексту;
· выберите «Страница» в меню «Тип». В меню «Страница» укажите номер страницы для перехода, задайте масштаб. Введите имя страницы или выберите параметр «Имя и номер страницы», чтобы присвоить имя привязке автоматически с учетом выбранного номера страницы и значения масштаба;
· выберите «URL» в меню «Тип». Введите или вставьте скопированный URL-адрес, например http://www.adobe.com/ru. При этом можно использовать любой допустимый протокол доступа к ресурсам Интернета: http://, file://, ftp:// или mailto://.
Создание гиперссылки к привязке к тексту
Выберите текст, фрейм или графику для использования в качестве источника гиперссылки. Выберите «Новая гиперссылка» в меню палитры «Гиперссылки» или нажмите кнопку
«Создать новую гиперссылку» в нижней части палитры «Гиперссылки».
Выберите «Привязка к тексту» в меню «Связать с».
В меню «Документ» выберите документ, содержащий привязку для перехода. Во всплывающем меню отобразится список всех сохраненных открытых документов. Если нужный документ не открыт, выберите «Обзор» во всплывающем меню, найдите файл, затем нажмите кнопку «Открыть».
В меню «Привязка к тексту» выберите привязку для созданной привязки к тексту. Укажите параметры оформления гиперссылки и нажмите «OK».
Создание гиперссылки к любой общей привязке

При создании гиперссылки, если выбран пункт «Общая привязка» в меню «Связать с», можно указать любую именованную привязку. Привязка становится именованной при добавлении URL- адреса в текстовом поле «URL» или при выборе пункта «Общая привязка гиперссылки» в процессе создания гиперссылки к URL-адресу, файлу или адресу электронной почты .
Выберите текст, фрейм или графику для использования в качестве источника гиперссылки. Выберите «Новая гиперссылка» в меню палитры «Гиперссылки» или нажмите кнопку
«Создать новую гиперссылку» в нижней части палитры «Гиперссылки».
В диалоговом окне «Новая гиперссылка» выберите «Общая привязка» в меню «Связать с».
В меню «Документ» выберите документ, содержащий привязку для перехода. Во всплывающем меню отобразится список всех сохраненных открытых документов. Если нужный документ не открыт, выберите «Обзор» во всплывающем меню, найдите файл, затем нажмите кнопку «Открыть».
Выберите привязку в меню «Имя».
Укажите параметры оформления гиперссылки и нажмите «OK».
Задание 2. Управление гиперссылками.
Для редактирования, удаления, восстановления или поиска гиперссылок используется палитра
«Гиперссылки». В InCopy возможно управление гиперссылками, если материал помечен как доступный для редактирования.
Редактирование гиперссылок
Щелкните правой кнопкой мыши текст или объект, представляющий собой гиперссылку, а затем выберите «Гиперссылки» > «Редактировать гиперссылку».
-ИЛИ-
В палитре «Гиперссылки» дважды щелкните элемент, который нужно отредактировать.
В диалоговом окне «Редактировать гиперссылку» внесите необходимые изменения в гиперссылки и нажмите «OK».
Удаление гиперссылок
После удаления гиперссылки текст и графика, применяемые в качестве источника, сохраняются.
Выберите в палитре «Гиперссылки» один или несколько элементов для удаления, затем нажмите кнопку «Удалить» в нижней части палитры.
Переименование источника гиперссылки
При переименовании источника гиперссылки будет изменен способ ее отображения в палитре
«Гиперссылки».
Выберите гиперссылку в палитре «Гиперссылки».
Выберите «Переименовать гиперссылку» в меню палитры «Гиперссылки» и укажите новое имя.
Редактирование или удаление привязок гиперссылок
Откройте документ, в котором находится привязка гиперссылки. Выберите «Параметры привязки» в меню палитры «Гиперссылки».
В меню «Привязка» выберите имя привязки, которое нужно отредактировать. Выполните одно из следующих действий:
· нажмите кнопку «Редактировать», затем внесите необходимые изменения;
· чтобы удалить привязку, нажмите кнопку «Удалить».
По окончании редактирования или удаления привязок нажмите кнопку «OK».
Восстановление или обновление гиперссылок

Выделите фрагмент текста, текстовый фрейм или графический фрейм, который будет использоваться в качестве нового источника гиперссылки. Например, можно выбрать дополнительный текст и включить его в источник.
Выберите гиперссылку в палитре «Гиперссылки». Выполните одно из следующих действий:
· выберите «Восстановить гиперссылку» в меню палитры «Гиперссылки»;
· чтобы обновить гиперссылки на внешние документы, выберите «Обновить гиперссылку» в меню палитры «Гиперссылки».
Переход к источнику гиперссылки или к точке привязки
Чтобы найти источник гиперссылки или перекрестной ссылки, выделите этот элемент в палитре «Гиперссылки». Выберите «Перейти к источнику» в меню палитры «Гиперссылки». Будет выделен текст или фрейм.
Чтобы определить привязку гиперссылки или перекрестной ссылки, выделите элемент в палитре «Гиперссылки». Выберите «Перейти к точке привязки» в меню палитры «Гиперссылки».
Если привязка представляет собой URL-адрес, то программа InDesign запустит веб-браузер, в котором отобразится привязка. Если элемент является привязкой к тексту или привязкой к странице, то программа InDesign перейдет в соответствующее расположение.
Цель: познакомиться с процессом создания кнопок навигации.
Теоретические вопросы
1. Кнопки навигации.
2. Использование готовых образцов.
3. Создание кнопок при помощи графических элементов.
Задание 1. Создание кнопки.
Нарисуйте контур кнопки с помощью инструмента «Карандаш» или инструмента рисования, например, «Прямоугольник» или «Эллипс». При необходимости воспользуйтесь инструментом
«Текст», чтобы добавить текст кнопки, например «Далее» или «Купить».
При помощи инструмента «Выделение»	выделите изображение, фигуру или текстовый фрейм, подлежащий преобразованию.[image: ]
Возможность преобразовать в кнопку фильм, звук или афишу не предусмотрена.
Нажмите   значок   «Преобразовать   объект   в   кнопку»   в   палитре   «Кнопки»   («Окно»   >
«Интерактивные элементы» > «Кнопки»). Либо выберите «Объект» > «Интерактивные элементы»
· «Преобразовать в кнопку». [image: ]
В палитре «Кнопки» выполните любое из следующих действий:
· в текстовом поле «Имя» укажите имя кнопки;
· укажите одно или несколько действий, выполняемых кнопкой по щелчку на ней в экспортированном файле PDF, SWF или EPUB с фиксированным макетом;
· активируйте дополнительные состояния и измените их оформление, чтобы задать внешний вид кнопки при наведении на нее курсора или при щелчке на ней в экспортированном файле PDF, SWF или EPUB с фиксированным макетом.

Проверьте   кнопку    с    помощью    панели    «Предварительный    просмотр»    («Окно»    >
«Интерактивность» > «Просмотр интерактивности EPUB» или «Просмотр SWF»), прежде чем экспортировать документ в интерактивный формат PDF, SWF или EPUB с фиксированным макетом.
Задание 2. Добавление кнопки из палитры «Образцы кнопок».
На палитре «Образцы кнопок» имеется множество предварительно созданных кнопок, которые можно перетаскивать в документ. В этих образцах кнопок реализованы такие эффекты, как «Градиентная растушевка» и «Тень», отображение этих кнопок незначительно отличается в оформлении «Курсор над кнопкой» (Rollover). Образцам кнопок также назначены действия. Например, образцам кнопок со стрелками предварительно назначены действия «Перейти на следующую страницу» или «Перейти на предыдущую страницу». Параметры этих кнопок можно изменить с учетом требований пользователя.
Палитра «Образцы кнопок» представляет собой библиотеку объектов. Эта библиотека объектов позволяет добавлять кнопки в палитру и удалять ненужные. Образцы кнопок хранятся в файле ButtonLibrary.indl, расположенном в папке Presets/Button Library папки приложения InDesign.
Чтобы открыть палитру «Образцы кнопок», выберите пункт «Образцы кнопок» из меню палитры «Кнопки».
Перетащите кнопку из палитры «Образцы кнопок» в документ. Если кнопки навигации должны отображаться на каждой странице, разместите их на странице-шаблоне.
Выделите выбранную кнопку с помощью инструмента «Выделение» и затем отредактируйте свойства кнопки в палитре «Кнопки».
При редактировании образцов кнопок необходимо иметь в виду следующее:
· при добавлении текста к кнопке не забудьте скопировать и вставить текст из состояния кнопки «Обычный» в состояние «Курсор над кнопкой». Иначе добавленный текст не отобразится при наведении курсора на кнопку в файле PDF, SWF или EPUB с фиксированным макетом;
· размеры кнопок можно изменять. При перетаскивании пары кнопок со стрелками «след. страница»/«пред. страница» измените размеры первой кнопки, затем выделите вторую кнопку и выберите меню «Объект» > «Повторить трансформирование» > «Повторить трансформирование».
Задание 3. Преобразование кнопки в объект.
При преобразовании кнопки в объект содержимое кнопки сохраняется на странице без использования свойств кнопки. Любое содержимое, связанное с другими состояниями кнопки, также удаляется.
При помощи инструмента «Выделение» выделите кнопку.[image: ]
Выберите «Объект» > «Интерактивные элементы» > «Преобразовать в объект».
Задание 4. Создание интерактивных кнопок.
В программе InDesign предусмотрена возможность создавать и редактировать интерактивные эффекты, а также управлять ими. После экспорта документа в формат PDF, SWF или EPUB с фиксированным макетом эти интерактивные действия могут становиться активными.
Например, нужно создать кнопку, воспроизводящую звук в документе PDF. Для этого можно поместить в документ InDesign звуковой файл, затем создать кнопку, которая запускает воспроизведение звука при нажатии на нее в документе PDF.

В данном примере щелчок кнопкой мыши является событием, а воспроизведение звука –
[image: ]действием.
Данная кнопка настраивается таким образом, что звук воспроизводится после отпускания кнопки мыши.
Добавление действий для кнопок
Для разных событий можно назначать различные действия. Например, в экспортированном файле PDF можно указать, что при наведении указателя мыши на кнопку воспроизводится определенный звук, а воспроизведение фильма запускается после того, как пользователь щелкнет эту кнопку и отпустит ее. Кроме того, для одного и того же события можно назначить несколько действий. Например, можно создать действие, которое запускает воспроизведение фильма и устанавливает для масштаба просмотра значение «Реальный размер».
Выделите созданную кнопку с помощью инструмента «Выделение».[image: ]
В палитре   «Кнопки»   выберите   событие,   например,   «При   отпускании»   (On   Release),
определяющее момент активации действия.
[image: ]Щелкните кнопку со значком «плюс» рядом со списком «Действия» и назначьте действие выбранному событию.
Укажите параметры действия.
Например, если выбрано действие «Перейти на первую страницу», укажите масштаб. Если выбрано действие «Перейти к URL», укажите адрес веб-страницы. Для некоторых действий, например, «Перейти к следующему виду», отсутствуют дополнительные настройки.
При необходимости продолжите добавление необходимых действий в событие.
Задание 5. Изменение внешнего вида кнопки при наведении курсора и щелчке мышью.
Кнопка состоит из группы отдельных объектов, каждый из которых отвечает за определенное оформление кнопки  (иногда называемое  «состоянием»).  Каждая  кнопка может  иметь до трех

состояний: «Не нажата», «Курсор над кнопкой» и «Нажата». В экспортированном файле кнопка находится в состоянии «Не нажата», если на нее не наведен указатель мыши (состояние «Курсор над кнопкой») или на ней не сделан щелчок кнопкой мыши (после щелчка кнопка переходит в состояние «Нажата»). Все состояния можно сделать различными по оформлению.
По умолчанию любая создаваемая кнопка отображается в состоянии «Не нажата» с соответствующим текстом или изображением. При активации нового состояния копируется оформление состояния «Не нажата». Чтобы сделать состояния отличающимися, можно изменить цвет, добавить текст или изображение. Ниже изображены состояния кнопки: A) указатель мыши не наведен на кнопку («Не нажата»); B) указатель мыши наведен на кнопку («Курсор над кнопкой»); C) щелчок указателя кнопки («Нажата»).
[image: ]

Задание 6. Изменение внешнего вида кнопок.
При создании кнопки с несколькими состояниями («Не нажата», «Курсор над кнопкой»,
«Нажата») следует выполнить ее дизайн до активации других состояний. При активации состояния «Курсор над кнопкой» или «Нажата» копируется состояние «Не нажата».
Некоторые изменения влияют только на выбранное состояние, в то время как другие изменения влияют на все активные состояния. Если выбрать состояние и затем изменить его фоновый цвет или отредактировать текст, это изменение повлияет только на выбранное состояние. Если для перемещения или изменения размера кнопки используется инструмент «Выделение», то это изменение повлияет на все состояния.
Чтобы отобразить палитру «Кнопки», выберите «Окно» > «Интерактивные элементы» >
«Кнопки».
При помощи инструмента «Выделение»	выделите в макете кнопку, которую необходимо изменить. [image: ]
Нажмите [Курсор над кнопкой], чтобы активировать состояние «Курсор над кнопкой».
Состояние «Не нажата» копируется в состояние «Курсор над кнопкой».
При выбранном состоянии «Курсор над кнопкой» измените оформление кнопки.
Чтобы изменить цвет, выберите образец в меню «Обводка» или «Заливка» на панели
«Управление».
Чтобы поместить изображение в выбранное состояние, выберите существующее изображение с помощью инструмента прямого выделения или дважды щелкните существующее изображение кнопки, затем выберите «Файл» > «Поместить» и дважды щелкните значок файла.
Чтобы вставить изображение в текстовый фрейм, скопируйте его в буфер обмена, выделите оформление в палитре «Кнопки», затем выберите «Редактирование» > «Вставить в».
Чтобы ввести текст, выберите инструмент «Текст», щелкните кнопку и введите текст. Чтобы скопировать вставленный текстовый фрейм, можно также выбрать «Редактирование» > «Вставить в».

Чтобы добавить состояние «Нажата», щелкните строку [Нажата] для ее активации, а затем выполните описанные выше действия по изменению оформления.
Воспользуйтесь палитрой «Предварительный просмотр» для проверки различных состояний кнопки.
Цели: познакомиться с технологиями перехода между страницами.
Теоретические вопросы
1. Оформление переходов страниц.
2. Просмотр параметров без выхода из программы.
Задание 1. Переходы страниц в документах, экспортируемых в форматы SWF или PDF,
позволяют	отобразить	при	переворачивании	страниц	декоративные	эффекты,	такие	как
«растворение» или «стирание». Можно назначить различные переходы для отдельных страниц или задать один переход для всех страниц. Переходы страниц особенно полезны при создании слайд- шоу в формате PDF или SWF.
Применение переходов страниц
Можно применить переходы страниц к отдельным или ко всем разворотам в документе. Переходы страниц появляются при экспорте документа InDesign в формат PDF или SWF. Нельзя применять переходы страниц к разным страницам внутри одного разворота или к страницам- шаблонам.
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В палитре «Страницы» выберите развороты, к которым следует применить переход страниц. Убедитесь, что разворот выбран, а не просто выделен. Номера под страницами в палитре
«Страницы» должны быть выделены.
Чтобы отобразить палитру «Переходы страниц», выберите «Окно» > «Интерактивные элементы» > «Переходы страницы».
Выберите способ перехода в меню «Переход».

Пользователи часто интересуются, необходимо ли выбирать переход «Перелистывание» (только для SWF), чтобы создать эффект переворачивания страниц в файле SWF. Нет необходимости применять этот параметр при ручном перелистывании страниц в файле SWF. Если в диалоговом окне «Экспорт SWF» установить флажок в поле «Включить интерактивное переворачивание страниц», то можно перелистывать страницы вручную путем перетаскивания угла в экспортированном SWF-файле либо использовать клавиши со стрелками или навигационные кнопки для активации перехода, примененного к данной странице.
Выполните настройку перехода, выбрав необходимые параметры в меню «Направление» и
«Скорость».
[image: ]Чтобы применить выбранный переход ко всем разворотам текущего документа, щелкните значок «Применить ко всем разворотам или выберите пункт «Применить ко всем разворотам» в меню палитры «Переходы страниц».
Выберите другой разворот в палитре «Страницы» и примените другой переход страницы. После применения перехода страницы к развороту рядом с разворотом в палитре «Страницы»
[image: ]появится значок перехода страниц . Эти значки можно скрыть в палитре «Страницы», для этого следует снять флажок в поле «Переходы страниц» диалогового окна «Параметры палитры».
Задание 2. Удаление переходов.
В палитре «Страницы» выберите разворот, для которого требуется выполнить удаление перехода, затем выберите пункт «Нет» в меню «Переход» палитры «Переход страницы».
Для удаления переходов из всех разворотов выберите пункт Очистить все в меню палитры
«Переходы страниц».
Задание 3. Просмотр переходов страниц в PDF.
Чтобы включить переходы страниц в экспортируемый документ PDF, выберите переход в меню «Переходы страниц» диалогового окна «Экспортировать в интерактивный файл PDF».
Чтобы просмотреть переходы страниц в экспортированном документе PDF, переключите отображение документа в полноэкранный режим нажатием клавиш «Ctrl»+«L» (Windows) в программе Adobe Acrobat или Adobe Reader. Нажмите клавишу «Esc», чтобы выйти из полноэкранного режима.
Цель: познакомиться с процессом создания закладок.
Теоретические вопросы
1. Закладки.
2. Создание закладок.
Задание 1. Создание закладок для PDF.
Закладка – это разновидность ссылки с описательным текстом, упрощающая перемещение по документам, экспортированным в формат Adobe PDF. Закладки, созданные в документе InDesign, отображаются на вкладке «Закладки» в левой части окна Acrobat или Adobe Reader. Каждая закладка указывает на привязку к тексту или страницу.

Элементы сформированного оглавления автоматически добавляются к содержимому палитры
«Закладки». Кроме того, предусмотрена возможность дополнительной настройки документа с закладками, позволяющей привлечь внимание читателя или еще больше упростить перемещение по документу. Области определения одних закладок могут быть вложенными в другие закладки.
Чтобы отобразить палитру «Закладки», выберите «Окно» > «Интерактивные элементы» >
«Закладки».
Щелкните закладку, в которую нужно поместить новую закладку. Если закладка не выделена, то новая закладка автоматически добавляется в конец списка.
Чтобы указать место для перехода по закладке, выполните одно из следующих действий:
· щелкните мышью в тексте, чтобы вставить точку ввода;
· выделите текст (по умолчанию выделенный текст становится надписью на закладке);
· чтобы просмотреть   страницу   в   окне   документа,   дважды   щелкните   ее   в   палитре
«Страницы».
Чтобы создать закладку, выполните одно из следующих действий:
· щелкните значок «Создать новую закладку» в палитре «Закладки»;
· выберите «Новая закладка» в меню палитры.
Закладки отображаются на вкладке «Закладки» при открытии экспортированного файла PDF в программе Adobe Reader или Acrobat.
Задание 2. Управление закладками.
Палитра «Закладки» предназначена для переименования, удаления и монтажа закладок.
Переименование закладки
Щелкните закладку в палитре «Закладки» и выберите в меню пункт «Переименовать закладку».
Удаление закладки
Щелкните закладку в палитре «Закладки» и выберите в меню пункт «Удалить закладку».
Переупорядочение, группировка и сортировка закладок
Список закладок можно сделать вложенным, чтобы показать отношения между разделами. При вложении формируется отношение родительских и дочерних элементов. Иерархический список можно разворачивать и сворачивать по мере необходимости. Изменение последовательности или порядка вложенности закладок не отражается на внешнем виде самого документа.
Выполните одно из следующих действий:
· чтобы развернуть или свернуть иерархию закладок, щелкните треугольник рядом со значком закладки. Отобразятся или будут скрыты все дочерние элементы этой закладки;
· чтобы вложить одну закладку в другую, выберите закладку (или несколько закладок), затем перетащите один или несколько значков на родительскую закладку. Отпустите перетаскиваемую закладку.
Перенесенные закладки будут вложены в родительскую закладку, но страница, на которой фактически находится закладка, остается в документе в своем первоначальном расположении.
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Палитра «Закладки», в которой отображаются закладки, вложенные в родительскую закладку Чтобы переместить закладки из положения, где они являются вложенными, сначала выберите
нужные закладки. Перетащите значки вниз и влево от родительской закладки. Появится черная полоса, указывающая, в какое место будут перемещены закладки. Отпустите перетаскиваемую закладку.
Чтобы изменить порядок расположения закладок, выберите закладку и переместите ее в новое место. Появится черная полоса, указывающая, в какое место будут помещены закладки.
Чтобы сортировать закладки, выберите «Сортировать закладки» в меню палитры «Закладки».
Закладки отображаются в том же порядке, в каком следуют соответствующие им страницы.
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Цели: познакомиться с основами создания анимации.
Теоретические вопросы
1. Создание объекта с несколькими состояниями
2. Создание анимации.
Задание 1. Анимация в документе с использованием стилей движения.
Стили движения представляют собой предварительно созданные эффекты анимации, которые быстро могут быть применены к объектам. Пользуйтесь палитрой «Анимация» для применения стилей движения и изменения таких настроек анимации, как длительность и скорость. На палитре
«Анимация» можно также указать, когда начинать воспроизведение анимации объекта.
Эти стили движения полностью соответствуют стилям в Adobe Flash CS5 Professional. Можно импортировать любой заказной стиль движения, созданный в Flash Professional. Кроме того, можно сохранить созданные стили движения и использовать их в InDesign или Flash Professional.
Поместите объект, который предполагается анимировать, в документ.
На палитре «Анимация» («Окно» > «Интерактивные элементы» > «Анимация») выберите стиль движения в меню «Стиль».
Укажите параметры стиля движения.
Чтобы изменить траекторию движения, используйте инструменты «Перо» и «Частичное выделение».
Для изменения порядка воспроизведения анимированных объектов используйте палитру
«Синхронизация».

Для	предварительного	просмотра	анимации	в	InDesign	используйте	палитру
«Предварительный просмотр».
Чтобы удалить эффекты анимации, выделите объект и нажмите значок «Удалить» на палитре
«Анимация».
Преобразование выделенных объектов в траекторию движения
Анимация может быть создана путем выделения объекта и контура с последующим преобразованием их в траекторию движения. При выделении двух замкнутых контуров, например, двух прямоугольников, верхний контур становится траекторией движения.
Выделите объект, который требуется анимировать, и контур, который предполагается использовать в качестве траектории движения.
Вы не можете преобразовать более двух выбранных объектов.
[image: ]На палитре «Анимация» нажмите кнопку «Преобразовать в траекторию движения»	.
Выберите нужные параметры на палитре «Анимация».
Параметры стилей движения
Параметры стилей движения отображаются на палитре «Анимация». Щелкните «Свойства», чтобы отобразить дополнительные параметры.
Имя
Укажите имя анимации. При настройке действия, которое запускает анимацию, очень важно указать понятное имя.
Стиль
Выберите стиль из списка заданных стилей.
Событие(я)
По умолчанию выбрано событие «При загрузке страницы»: воспроизведение анимированного объекта начинается, когда страница открывается в файле SWF. Выберите «При щелчке страницы», чтобы анимация запускалась при щелчке на странице. Выберите «При щелчке (самозапуск)» или
«При наведении курсора (самозапуск)», чтобы анимация запускалась при щелчке или наведении курсора на объект. При создании события кнопки, запускающего анимацию, выбирается «При событии кнопки». Можно указать несколько событий, которые будут запускать анимацию.
При выборе события «При наведении курсора (самозапуск)» можно также выбрать «Сброс при отведении курсора». Этот параметр сбрасывает анимацию в начальное состояние, когда курсор отводится от объекта.
Создать триггер кнопки
Нажмите эту кнопку, чтобы запустить анимацию щелчком на существующем объекте или кнопке. Нажмите кнопку «Создать триггер кнопки» [image: ], а затем щелкните объект, который будет запускать анимацию. При необходимости объект преобразуется в кнопку, открывается палитра
«Кнопки».
Длительность
Определяет продолжительность анимация.
Воспроизведение
Укажите количество циклов воспроизведения анимации или выберите «По кругу», чтобы циклически повторять анимацию, пока она не будет остановлена.
Скорость

Выберите воспроизведение анимации с постоянной скоростью («Нет»), с ускорением («Ускорение») или замедлением («Замедление»).
Анимация
Выберите «Из текущего оформления», чтобы использовать текущие свойства объекта (процент масштабирования, угол поворота и положение) в качестве отправной точки для анимации.
Выберите «До текущего оформления», чтобы текущие свойства объекта служили конечной точкой анимации. Этот параметр особенно удобен в слайд-шоу. Например, объекты,
«появляющиеся» на странице извне, могут появляться на самой странице, а не на монтажной области, в результате чего внешний вид печатного документа улучшается.
Выберите параметр «До текущего положения», чтобы текущие свойства объекта использовались в качестве отправной точки для анимации, а положение объекта — в качестве конечной точки. Этот параметр аналогичен параметру «Из текущего оформления» с той разницей, что движение объекта завершается в текущем положении, а траектория движения смещена. Этот параметр особенно полезен для определенных стилей, например размытия и затухания, чтобы объект не появлялся в нежелательном состоянии в конце анимации. Ниже показаны настройки анимации: A) объект и траектория до анимации; B) из текущего оформления; C) до текущего оформления; D) до текущего положения.
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Поворот
Укажите угол поворота объекта во время анимации.
Исходный файл
Используйте экранную версию, чтобы указать исходную точку траектории движения анимированного объекта.
Масштаб
Укажите значение в процентах, определяющее увеличение или уменьшение размера объекта в процессе анимации.
Непрозрачность
Выберите параметр, определяющий, будет ли анимация оставаться постоянно видимой («Нет»), постепенно появляться («Медленное появление») или постепенно исчезать («Медленное исчезновение»).
Видимость
Выберите «Скрыть до выполнения анимации» или «Скрыть после выполнения анимации», чтобы скрыть объект до или после воспроизведения.
Задание 2. Управление стилями движения.

Настройки анимации могут быть сохранены как стили движения для повторного использования в InDesign. Кроме того, можно импортировать стили из XML-файлов, которые можно открыть в Flash Professional или использовать совместно с другими пользователями InDesign.
Сохранение стилей движения для повторного использования
Пользовательские стили   отображаются   в   верхней   части   меню   «Стили»   на   палитре
«Анимация».
Установите необходимые параметры на палитре «Анимация». Нажмите «Сохранить» в меню палитры «Анимация».
Введите имя стиля и нажмите «OK».
Удаление пользовательских стилей движения
Воспользуйтесь диалоговым окном «Управлять стилями», для удаления стилей движения, которые были сохранены, скопированы или импортированы. Стили движения, отображаемые в скобках, являются встроенными стилями InDesign, их нельзя удалить. При удалении стиля движения он удаляется из меню «Стили» и из компьютера.
Выберите «Управлять стилями» из меню палитры «Анимация». Выберите стиль, который необходимо удалить, и нажмите «Удалить». Дублирование стилей движения
Выберите «Управлять стилями» из меню палитры «Анимация».
Выберите стиль, дубликат которого вы хотите создать, и нажмите «Создать дубликат».
Сохранение стилей движения в виде файлов XML
Сохранение стилей движения в виде файлов XML полезно, если предполагается использование стиля движения совместно с другими пользователями InDesign или если необходимо открыть стиль движения в программе Flash Professional.
При сохранении стиля движения в виде файла XML сохраняется траектория движения, а также длительность, скорость, масштаб, поворот и прозрачность.
Выберите «Управлять стилями» из меню палитры «Анимация». Выберите стиль и нажмите кнопку «Сохранить как».
Укажите имя и местоположение сохраняемого стиля движения и нажмите «Сохранить».
Импорт стилей движения
Пользователь может импортировать стили движения, экспортированные из InDesign или Flash
Professionalкак XML-файлы.
Выберите «Управлять стилями» из меню палитры «Анимация». Нажмите кнопку «Загрузить».
Дважды щелкните файл .xml, который необходимо импортировать.
Задание 3. Изменение траектории движения.
При выборе анимированного объекта рядом отображается его траектория движения: A)
начальная точка; B) Конечная точка.

[image: ]

Чтобы изменить траекторию движения, выполните одно из следующих действий:
· при помощи инструментов «Частичное выделение» и «Перо» измените траекторию движения, пользуясь теми же методами, что и при редактировании контуров;
· [image: ]чтобы создать траекторию движения на основе существующего контура, выделите контур и объект и нажмите кнопку «Преобразовать в траекторию движения» на палитре «Анимация»;
· чтобы изменить направление траектории, на палитре «Анимация» щелкните «Свойства» и в меню «Анимировать» выберите нужный параметр. Можно также выделить траекторию движения и выбрать «Объект» > «Контуры» > «Изменить направление контура». Если требуется изменить направление траектории не перемещая объект, удалите анимацию, измените направление траектории и создайте анимационный эффект заново.

ЛИТЕРАТУРА

Информационное обеспечение 
Для реализации программы библиотечный фонд образовательной организации должен иметь печатные и/или электронные образовательные и информационные ресурсы, рекомендуемые для использования в образовательном процессе.

Печатные издания
[bookmark: _Hlk54562321]1. Усатая Т.В.и др. Дизайн-проектирование. - М.: ОИЦ «Академия», 2019. ББК 30.18:5-05я723

Дополнительная литература:
            Академия Л. М. Корпан, А. А. Балканский, Л. П. Сопроненко [и др.]
Проектная графика. - М.: ОИЦ «Академия», 2018.
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OtkpbiTas BEpCTKA (a)- C UANIOCTPALAMM HaA WM
1107 TeKCTOM NooCh;

3akpeitan Béperka (6)- c unlocTpaLUAMY,
TIOMELLEHHbIMY BHY TPV TEKCTa 1 PaHMYALIAMA C
TEKCTOM 110 Z1BYM W TPeM CTOpOHaM;

Tnyxas BEpCTa (8) - KOTAA B MAKETE MHOTO KOOHOK,
V1 PACTIONOXEHHbIE BHYTPY TEKCTa WIMIOCTPaLIAW BCemi
YeTbIPLMA CTOPOHAMM CONPUKACAIOTCA C TEKCTOM;

Bépcra spaspes (6) - nonepemeHHo unnioCTpaL
VA TEKCT, NPV 3TOM TEKCT AENUTCA WTIOCTPALMAMA Ha
bparmenTs;

Bépcra B 06opKy (a)- B yrny pasmeuiena
WATIOCTPaUWS, 3 C [1BYX CTOPOH OHa OKPYXeHa TeKCTOM;

BEpCTia Ha MoAAX (r) - TaK MOXHO NOMECTATb Menkie
P —

Bépcrka B 06pes (1) - U306paKeHve BHIXORUT Ha
3-5MM 33 rpaHULb CTPAHILbI

BépcTKa C BbIXOA0M Ha NONe (€) - Tak MOKHO
pasmecTuTh Gonee KpynHylo uARIOCTPALMIO




